About This Document

This manual is intended for administrators and users of the AXIS 213 PTZ Network Camera, and is applicable for software release 4.3. Previous experience of networking will be of use when installing and using this product. Some knowledge of UNIX or Linux-based systems would also be beneficial, for developing shell scripts and applications. Later versions of this document will be posted to the Axis Website, as required.

Safety Notices Used In This Manual

Caution! - Indicates a potential hazard that can damage the product.
Important! - Indicates a hazard that can seriously impair operation. Do not proceed beyond any of the above notices until you have fully understood the implications.

Intellectual Property Rights

Axis AB has intellectual property rights relating to technology embodied in the product described in this document. In particular, and without limitation, these intellectual property rights may include one or more of the patents listed at http://www.axis.com/patent.htm and one or more additional patents or pending patent applications in the US and other countries.
This product contains licensed third-party software. See the menu item “About” in the product’s user interface for more information.
This product contains source code copyright Apple Computer, Inc., under the terms of Apple Public Source License 2.0 (see http://www.opensource.apple.com/apsl/).
The source code is available from: http://developer.apple.com/darwin/projects/bonjour/

Legal Considerations

Camera surveillance can be prohibited by laws that vary from country to country. Check the laws in your local region before using this product for surveillance purposes.

Electromagnetic Compatibility (EMC)

USA – This equipment generates, uses, and can radiate radio frequency energy and if not installed and used in accordance with the instruction manual, may cause interference to radio communications. It has been tested and found to comply with the limits for a Class B computing device pursuant to Subpart B of Part 15 of FCC rules, which are designed to provide reasonable protection against such interference when operated in a commercial environment. Operation of this equipment in a residential area is likely to cause interference, in which case the user at his/her own expense will be required to take whatever measures may be required to correct the interference. Shielded cables should be used with this unit to ensure compliance with the Class B limits.

Canada – This Class B digital apparatus complies with Canadian ICES-003.

Europe – This digital equipment fulfills the requirements for radiated emission according to limit B of EN55022:1998, and the requirements for immunity according to EN55024:1998 residential, commercial, and light industry.

Japan – This is a class B product based on the standard of the Voluntary Control Council for Interference from Information Technology Equipment (VCCI). If this is used near a radio or television receiver in a domestic environment, it may cause radio interference. Install and use the equipment according to the instruction manual.

Australia – This electronic device meets the requirements of the Radio communications (Electromagnetic Compatibility) Standard 1998 AS/NZS 3548.

Liability

Every care has been taken in the preparation of this manual; Please inform your local Axis office of any inaccuracies or omissions. Axis Communications AB cannot be held responsible for any technical or typographical errors and reserves the right to make changes to the product and manuals without prior notice. Axis Communications AB makes no warranty of any kind with regard to the material contained within this document, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose. Axis Communications AB shall not be liable nor responsible for incidental or consequential damages in connection with the furnishing, performance or use of this material.

Trademark Acknowledgements

Ethernet, Internet Explorer, Linux, Macintosh, Microsoft, Mozilla, Netscape Navigator, UNIX, Windows, WWW are registered trademarks of the respective holders. Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States and other countries. UPnP is a certification mark of the UPnP Implementers Corporation. Axis Communications AB is independent of Sun Microsystems Inc.

Axis Customer Services

Should you require any technical assistance, please contact your Axis reseller. If your questions cannot be answered immediately, your reseller will forward your queries through the appropriate channels to ensure a rapid response. If you are connected to the Internet, you can:

- download user documentation and firmware updates
- find answers to resolved problems in the FAQ database
- search by product, category, or phrases
- report problems to Axis support staff by logging in to your private support area.

Visit the Axis Support Web at www.axis.com/techsup/

RoHS

This product complies with both the European RoHS directive, 2002/95/EC, and the Chinese RoHS regulations, ACPEIP.

WEEE Directive

The European Union has enacted a Directive 2002/96/EC on Waste Electrical and Electronic Equipment (WEEE Directive). This directive is applicable in the European Union member states.

The WEEE marking on this product (see right) or its documentation indicates that the product must not be disposed of together with household waste. To prevent possible harm to human health and/or the environment, the product must be disposed of in an approved and environmentally safe recycling process. For further information on how to dispose of this product correctly, contact the product supplier, or the local authority responsible for waste disposal in your area.

Business users should contact the product supplier for information on how to dispose of this product correctly. This product should not be mixed with other commercial waste.

Safety Notice - Battery Replacement

The AXIS 213 uses a 3.0V CR2032 Lithium battery as the power supply for its internal real-time clock (RTC). This battery will under normal conditions last for a minimum of 5 years. Low battery power affects the operation of the RTC, causing it to reset at every power-up. A log message will appear when battery replacement is required. The battery should not be replaced unless required!

If the battery does need replacing, please observe the following points:

- Caution! Danger of Explosion if battery is incorrectly replaced
- Replace only with the same or equivalent battery, as recommended by the manufacturer.
- Dispose of used batteries according to the manufacturer's instructions.

AXIS 213 User's Manual
Revision 4.1
Dated: January 2008
Part No: 31136
Copyright© Axis Communications AB, 2005 - 2007

Visit the Axis Support Web at www.axis.com/techsup/
# Table of contents

Product Description .................................................. 5  
AXIS 213 PTZ Network Camera .................................. 5  
Accessing the camera .............................................. 7  
Access from a browser ........................................... 7  
Setting the Password ............................................. 7  
Accessing the camera from the Internet ....................... 7  
The Live View page .................................................. 8  
Video and Audio Streams .......................................... 11  
Video Stream Types ............................................... 11  
MPEG-4 protocols and communication methods ............... 12  
AXIS Media Control ............................................... 12  
How to stream MPEG-4 ........................................... 12  
Other methods of accessing the video stream .................. 13  
Setup ........................................................................ 14  
Accessing the setup tools from a browser ....................... 14  
AXIS Media Control ............................................... 14  
Video & Image ......................................................... 15  
Image ................................................................. 15  
Overlay image ....................................................... 16  
Advanced - Camera ............................................... 16  
Advanced - MPEG-4 ............................................... 17  
Audio ........................................................................ 19  
Audio - Basic ......................................................... 19  
Audio - Advanced .................................................. 20  
Live View Config ...................................................... 21  
Live View Layout .................................................... 21  
HTML Examples ..................................................... 23  
External Video ...................................................... 23  
PTZ Configuration .................................................... 24  
Preset Positions ...................................................... 24  
Sequence Mode ...................................................... 24  
Advanced - Limits .................................................. 24  
Advanced - Ctrl Panel ............................................. 24  
Advanced - Control Queue ........................................ 24  
Event Configuration .................................................. 25  
Event Servers ....................................................... 25  
Event Types .......................................................... 26  
Motion Detection .................................................... 27  
Port Status ............................................................ 28  
System Options ....................................................... 29  
Security - users ..................................................... 29
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security - IP Address Filter</td>
<td>29</td>
</tr>
<tr>
<td>Date &amp; Time Settings</td>
<td>29</td>
</tr>
<tr>
<td>Network - Basic TCP/IP Settings</td>
<td>30</td>
</tr>
<tr>
<td>Network Advanced TCP/IP Settings</td>
<td>30</td>
</tr>
<tr>
<td>Network - SOCKS</td>
<td>32</td>
</tr>
<tr>
<td>Network - SMTP (email)</td>
<td>32</td>
</tr>
<tr>
<td>Network - UPnP</td>
<td>32</td>
</tr>
<tr>
<td>Network - RTP/MPEG-4</td>
<td>32</td>
</tr>
<tr>
<td>Network - Bonjour</td>
<td>32</td>
</tr>
<tr>
<td>Ports &amp; Devices</td>
<td>33</td>
</tr>
<tr>
<td>Ports &amp; Devices - LED Settings</td>
<td>33</td>
</tr>
<tr>
<td>Ports &amp; Devices - Maintenance</td>
<td>33</td>
</tr>
<tr>
<td>Support - Support Overview</td>
<td>33</td>
</tr>
<tr>
<td>Support - System Overview</td>
<td>33</td>
</tr>
<tr>
<td>Support - Logs &amp; Reports</td>
<td>33</td>
</tr>
<tr>
<td>Advanced - Scripting</td>
<td>34</td>
</tr>
<tr>
<td>Advanced - Plain Config</td>
<td>34</td>
</tr>
<tr>
<td>Resetting to Factory Default Settings</td>
<td>34</td>
</tr>
<tr>
<td>Connection Module</td>
<td>35</td>
</tr>
<tr>
<td>AUDIO IN/OUT</td>
<td>35</td>
</tr>
<tr>
<td>Inputs and outputs (I/Os)</td>
<td>35</td>
</tr>
<tr>
<td>VIDEO IN</td>
<td>35</td>
</tr>
<tr>
<td>VIDEO OUT</td>
<td>35</td>
</tr>
<tr>
<td>RS-232C</td>
<td>35</td>
</tr>
<tr>
<td>Schematic Diagram - Connection Module</td>
<td>36</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>37</td>
</tr>
<tr>
<td>Checking the Firmware</td>
<td>37</td>
</tr>
<tr>
<td>Upgrading the Firmware</td>
<td>37</td>
</tr>
<tr>
<td>Support</td>
<td>38</td>
</tr>
<tr>
<td>Symptoms, Possible Causes and Remedial Actions</td>
<td>39</td>
</tr>
<tr>
<td>Technical Specifications</td>
<td>42</td>
</tr>
<tr>
<td>General performance considerations</td>
<td>44</td>
</tr>
<tr>
<td>Optimizing your system</td>
<td>45</td>
</tr>
<tr>
<td>Frame rates - Motion JPEG</td>
<td>45</td>
</tr>
<tr>
<td>Frame rates - MPEG-4</td>
<td>45</td>
</tr>
<tr>
<td>Bandwidth</td>
<td>46</td>
</tr>
<tr>
<td>Glossary of Terms</td>
<td>47</td>
</tr>
<tr>
<td>Index</td>
<td>53</td>
</tr>
</tbody>
</table>
Product Description

The AXIS 213 PTZ Network Camera is a fully featured PTZ network camera for security surveillance and remote monitoring. Images from the camera are made available on the network as real-time, full frame rate Motion JPEG streams and/or MPEG-4 video streams. The AXIS 213 also has an infrared (IR) lamp and a removable IR filter for day and night operation.

The AXIS 213 PTZ can optionally be equipped with a connection module that provides 2 inputs and 3 outputs, which can be connected to external devices, such as door sensors. The connection module also provides Audio IN/OUT connections, thus providing support for 2-way audio. For more information on the connection module see page 35.

Video can be viewed in 5 resolutions (up to 768x576). Up to 20 viewers can access the AXIS 213 PTZ simultaneously when using Motion JPEG and MPEG-4 unicast. The number of simultaneous viewers can be increased by using multicast MPEG-4.

The AXIS 213 PTZ contains advanced scheduling tools that can be used to trigger an event. As the AXIS 213 PTZ is designed for use in security systems, it is equipped with security features such as IP address filtering and multilevel passwords. The AXIS 213 PTZ has a built-in Web server, providing full access to all features through the use of a standard Web browser.

AXIS 213 PTZ Network Camera

1. **IR lamp** - infrared lamp for night vision. Activated from the AXIS 213 PTZ web page.

2. **Network indicator** - the multi-colored network indicator flashes as follows:
   - **Amber** - flashes for activity on a 10 Mbit/s network
   - **Green** - flashes for activity on a 100 Mbit/s network
   - **Red** - flashes for a failed firmware upgrade
   - **None** - no connection or disabled by the administrator

3. **Network Connector** - the AXIS 213 PTZ connects to the network via a standard RJ-45 connector, and detects the speed of the local network segment (10BaseT/100BaseTX Ethernet).

4. **Output/Input Connector** - for connection of the connection module cable. See below for further information.

5. **Power Connector** - for connection of the supplied power adapter.

The **Reset button** is located on the underside of the unit. This is used to restore the factory default settings, as described in *Resetting to Factory Default Settings*, on page 34.

The **Serial number** is located on the label on the underside of the unit.
**Connection module (optional accessory)** - this module provides the physical interface to three relay outputs, two digital inputs, audio in/out, video in/out and the RS-232C serial port. See **Connection Module**, on page 35 for more information.

**Note:** For information on installing the AXIS 213 PTZ, please refer to the Installation Guide.
Accessing the camera

The AXIS 213 PTZ can be used with most standard operating systems and supports Microsoft Internet Explorer 6.x or later, Netscape 7.x or later and Firefox 1.4 or later.

Note: To view streaming video in Microsoft Internet Explorer for Windows, you must set your browser to allow the AXIS Media Control (AMC) to be installed on your computer. The first time an MPEG-4 video stream is accessed, AMC also installs an MPEG-4 decoder for viewing the video stream. As a license is required for each instance of the decoder, the product administrator may have disabled the installation. If your workstation restricts the use of additional software components, the camera can be configured to use a Java applet for updating JPEG images. See the online help for more information.

Access from a browser

1. Start a browser (Internet Explorer, Firefox, Netscape Navigator).
2. Enter the IP address or host name of the AXIS 213 PTZ in the location/address field of your browser.
3. Enter the user name and password set by the administrator.
4. A video image is displayed in your browser.

Note:
• User functions in the AXIS 213 PTZ may have been customized to meet the specific requirements of the application. Consequently, many of the examples and functions in this section may differ from those displayed in your Live View page.
• If the AXIS 213 PTZ is to be placed upright on a desktop, the image must be rotated.
   Go to Setup > Video & Image and set Rotate image to 180 degrees.

Setting the Password

1. When accessing the camera for the first time, the ‘Configure Root Password’ dialog is displayed on the screen.
2. Enter a password and then re-enter it, to confirm the spelling. Click OK.
3. The ‘Enter Network Password’ dialog appears.
   Enter the User name: root
   Note: The default administrator user name root is permanent and cannot be deleted or altered.
4. Enter the password as set in step 2 above, and click OK. If the password is lost, the camera must be reset to the factory default settings. See page 34.
5. If required, click Yes to install the AXIS Media Control (AMC). You require administrator rights on the computer to do this.

Accessing the camera from the Internet

Once installed, the camera is accessible on your local network (LAN). To access the camera from the Internet you must configure your router/firewall to allow incoming data traffic. For security reasons this is usually done on a specific port. Please refer to the documentation for your router/firewall for further instructions.

For more information, please visit the AXIS Internet Dynamic DNS Service at www.axiscam.net or, for technical notes on this and other topics, visit the Axis Support Web at www.axis.com/techsup.
The Live View page
The following provides an overview of each button on the Live View page. If the AXIS 213 PTZ has been customized, the buttons are displayed accordingly:

The Video Format drop-down list allows temporary change of the video format on the Live View page.

The two types of Output button control the output directly from the Live View page. These are configured from Setup > Live View Config > Layout.

These buttons start/stop the Sequence Mode which automatically displays the view from preset positions at set intervals. Sequence mode is configured in Setup > PTZ Configuration > Sequence Mode.

The source list is used to select preset positions already configured in the camera. These are created in Setup > PTZ Configuration > Preset Positions. The list also shows video from external video sources, which are configured from Live View Config > External Video.

The Manual trigger buttons trigger an action directly from the Live View page. These buttons are configured under Setup > Live View Config > Layout. Click these buttons to manually start and stop events.

Use the Snapshot button to capture a snapshot of the image currently displayed in the window. Right-click on the image to save it in JPEG format on your computer.

Pan/Tilt/Zoom controls
The Live View page also displays the Pan/Tilt/Zoom controls. These are enabled/disabled for specified users by the administrator under System Options > Security > Users > User List.

Note: Setting the iris and focus manually disables Auto iris/Auto focus.
Control panel

Click the Ctrl panel button to display the control panel, which provides the following settings:

- **Auto focus**: Automatically adjusts the image focus.
- **Auto iris**: Automatically adjusts the amount of light reaching the camera and gives best results. This also protects the image sensor from strong light.
- **Backlight comp**: Enabling backlight compensation makes the subject clearer if the image background is too bright, or if the subject is too dark.
- **IR cut filter**: When set to off, the camera is able to “see” infrared light, for example at night, thus making the image clearer. The image is shown in black & white when the IR cut filter is off.
- **Shortcuts**: These buttons can be configured to provide direct access to various built-in auxiliary commands provided by the PTZ driver. See Advanced - Ctrl Panel on page 24.

Viewer controls

The default viewer to use for displaying moving images is selected from Setup > Live View Config > Layout.

The AMC viewer toolbar is available in Microsoft Internet Explorer for Windows only. See AXIS Media Control, on page 12 for more information. The AMC viewer toolbar displays the following buttons:

- The **Play/Stop** buttons start and stop the live video stream.
- The **Snapshot** button takes a snapshot of the displayed image. The Snapshot function and the target directory for saving snapshots can be configured from AMC (AXIS Media Control), which is available from the Windows Control Panel (Internet Explorer for Windows only).
- Click the **View Full Screen** button and the video image fills the entire screen area. Press Esc (Escape) on the computer keyboard to cancel full screen view.
- These buttons change the navigation mode. Selecting **Center** moves the camera view to center on the position clicked. The joystick mode moves the camera in the direction indicated by a mouse click, relative to the center of the image. The further from the center the image is clicked, the greater the movement. These modes can also be selected by right-clicking in the image.
- Click the **Mute & Microphone** buttons to switch the sound off and on. These are only available if audio is enabled and the connection module with a loudspeaker/microphone is connected.
- Use the sliders to control the volume on the speaker and microphone. The volume can be set between 0 and 100.
- When using the **Half-duplex** mode this button toggles between allowing you to speak and listen. The first icon indicates that you can talk and the speaker attached to the camera plays your voice. The second indicates that you hear audio from the camera, but no audio is sent to web clients. When in **Simplex** talk mode, the icon allows you to speak and is dimmed when you do not want other clients to receive audio.
Area Zoom
This allows you to draw a box over a desired area to zoom into. To activate, click the Center button described in the AMC viewer toolbar, or in other Internet browsers, select PTZ > Center. Using your mouse, click in the image and, while holding down the left mouse button, draw a square over the area you would like to zoom into. This functionality may need to be calibrated before use. This is done from Setup > PTZ Configuration > Advanced > Calibration.

Server push (not available for Microsoft Internet Explorer)
With this method, the AXIS 213 PTZ maintains and controls an open HTTP connection to the browser and sends data as and when required, for as long as required.

QuickTime
For use with MPEG-4 only. Note that in the settings for Video & Image > Advanced > MPEG-4, the Video object type must be set to Simple.

Java applet
This alternative uses a Java applet to update the images in the browser. No download is required. Note that when this alternative is selected, external video sources are not available on the live view page, and audio is mono-directional only (to the client).

Still Image
Displays still images only. Click your browser’s Refresh button to view a new image.

PTZ Control Queue
Only one user can use the Pan/Tilt/Zoom controls at any time. When multiple users are accessing the AXIS 213 PTZ’s Live View page, they are queued and assigned a set period during which they have the use of the PTZ controls. Use the buttons to request or release control of the PTZ controls.

The PTZ Control Queue is set up by the administrator under PTZ Configuration > Control Queue.
Video and Audio Streams

The AXIS 213 PTZ provides several different image and video formats. Your requirements and the properties of your network determine what you use.

The Live View page in the AXIS 213 PTZ provides access to Motion JPEG and MPEG-4 video streams, as well as to single JPEG images. Other applications and clients can also access these video and audio streams/images directly, without going via the Live View page.

Video Stream Types

Motion JPEG
This format uses standard JPEG still images in the video stream. These images are then displayed and updated at a rate sufficient to create a stream that shows constantly updated motion.

The Motion JPEG stream uses considerable amounts of bandwidth, but also provides excellent image quality and access to every individual image in the stream.

Note also that multiple clients accessing Motion JPEG streams can use different image settings.

MPEG-4
This is a video compression standard that makes good use of bandwidth, and which can provide high-quality video streams at less than 1 Mbit/s.

The MPEG-4 standard provides scope for a large range of coding tools for various applications in different situations, and the AXIS 213 PTZ provides certain subsets of these tools. These are represented as Video object types, which are selected for use with different viewing clients. The supported video object types are:

- **Simple** - sets the coding type to H.263, as used by QuickTime™.
- **Advanced Simple** - sets the coding type to MPEG-4 Part 2, as used by AMC (AXIS Media Control)

When using MPEG-4 it is also possible to control the bit rate, which in turn allows bandwidth control. CBR (constant bit rate) is used to achieve a specific bit rate by varying the quality of the MPEG-4 stream. When using VBR (variable bit rate), the quality of the video stream is kept as constant as possible, at the cost of a varying bit rate.

Notes:

- MPEG-4 is licensed technology. The AXIS 213 PTZ includes one viewing client license. Installing additional unlicensed copies of the viewing client is prohibited. To purchase additional licenses, contact your Axis reseller.
- All clients viewing the MPEG-4 stream must use the same image settings.
MPEG-4 protocols and communication methods
To deliver live streaming video over IP networks, various combinations of transport protocols and broadcast methods are employed.

- **RTP (Realtime Transport Protocol)** is a protocol that allows programs to manage the real-time transmission of multimedia data, via unicast or multicast.

- **RTSP (Real Time Streaming Protocol)** serves as a control protocol, to negotiate the transport protocol to use for the stream. RTSP is thus used by a viewing client to start a unicast session, see below.

- **UDP (User Datagram Protocol)** is a communications protocol that offers limited service for exchanging data in a network that uses the Internet Protocol (IP). UDP is an alternative to the Transmission Control Protocol (TCP). The advantage of UDP is that it is not required to deliver all data and may drop network packets when there is network congestion, for example. This is suitable for live video, as there is no point in re-transmitting old information that is not displayed anyway.

- **Unicasting** is communication between a single sender and a single receiver over a network. This means that the video stream goes independently to each user, and each user gets their own stream. A benefit of unicasting is that if one stream fails, it only affects one user.

- **Multicast** is bandwidth-conserving technology that reduces bandwidth usage by simultaneously delivering a single stream of information to multiple network users. This technology is used primarily on delimited networks (intranets), as each user needs an uninterrupted data flow and should not rely on network routers.

**AXIS Media Control**
The recommended method of accessing live video (MPEG-4 and/or Motion JPEG) and audio from the AXIS 213 PTZ is to use the AXIS Media Control (AMC) in Microsoft Internet Explorer for Windows. This ActiveX component is automatically installed on first use, after which it can be configured by opening the AMC Control Panel applet from the Windows Control Panel. Alternatively, right-click the video image in Internet Explorer.

**How to stream MPEG-4**
Your viewing requirements, and the properties of your network determine the combination of protocols and methods used. Setting the preferred method(s) is done in the control applet for AMC, which is found in the Windows Control Panel. When this has been set, AMC tests all the selected methods in the specified order, until the first functioning one is found.

**RTP+RTSP**
This method (actually RTP over UDP and RTSP over TCP) should be your first consideration for live video, especially to always have an up-to-date video stream, even if some images get dropped. This can be configured as multicast or unicast.

Multicasting provides the most efficient usage of bandwidth, especially when there are large numbers of clients viewing simultaneously. Note however, that a multicast broadcast cannot pass a network router unless the router is configured to allow this. It is thus not possible to multicast over the Internet.

Unicasting should be used for video-on-demand broadcasting, so that there is no video traffic on the network until a client connects and requests the stream. However, as more and more unicast clients connect, the traffic on the network increases and may cause congestion. Although there is a maximum of 20 unicast viewers, note that all multicast users combined count as 1 unicast viewer.

**RTP/RTSP**
This unicast method is RTP tunneled over RTSP. This can be used to exploit the fact that it is relatively simple to configure firewalls to allow RTSP traffic.

**RTP/RTSP/HTTP**
This method can also be used to traverse firewalls. Firewalls are commonly configured to allow the HTTP protocol, thus allowing RTP to be tunneled.
Other methods of accessing the video stream

Video/images from the AXIS 213 PTZ can also be accessed in the following ways:

- If supported by the client, the AXIS 213 PTZ can use Motion JPEG server push to display video. This option maintains an open HTTP connection to the browser and sends data as and when required, for as long as required.
- As single JPEG images in a browser. Enter the path: http://<IP address>/axis-cgi/jpg/image.cgi?resolution=CIF
- Windows Media Player. This requires AMC and the MPEG-4 decoder to be installed. The paths that can be used are listed below, in the order of preference.
  - Unicast via RTP: axrtpu://<IP address>/mpeg4/media.amp
  - Unicast via RTSP: axrtsp://<IP address>/mpeg4/media.amp
  - Unicast via RTSP, tunneled via HTTP: axrtsphttp://<IP address>/mpeg4/media.amp
  - Multicast: axrtpm://<IP address>/mpeg4/media.amp

Other MPEG-4 clients

Although it may be possible to use other clients to view the MPEG-4 stream, this is not guaranteed by Axis.

For other clients, such as QuickTime™ the Video Object Type must be set to Simple. It may also be necessary to adjust the advanced MPEG-4 settings.

To assess the video stream from QuickTime™ the following path can be used:

rtsp://<IP address>/mpeg4/media.amp

This path is for all supported methods, and the client negotiates with the AXIS 213 PTZ to determine which transport protocol to use.

Audio transmission methods

The audio stream can be accessed in the Live View page when viewing either Motion JPEG or MPEG.

Using Motion JPEG

The basic transmission method of audio used in conjunction with Motion JPEG video streaming is transmission over HTTP. The video and audio streams are not synchronized when using Motion JPEG so the streams may be slightly out of sync. The latency in any stream should be low, but this depends on the network infrastructure.

Using MPEG-4

When using MPEG-4, audio is streamed using the same protocol as the video stream.

When audio is transmitted using MPEG-4, the Axis product sends synchronization information along with the streams to the client that is performing the synchronization.

Audio is streamed from the client to the server over HTTP when using Motion JPEG and MPEG-4.

Accessing the Audio Streams

In addition to accessing audio in the Live View page using AMC, audio from the Video Server can also be accessed in the following ways:

HTTP-API

You can read about accessing audio for the other protocols through the HTTP-API at http://www.axis.com/techsup.

QuickTime/Windows Media Player

It is possible to use QuickTime and Windows Media Player to listen to the audio stream using the same methods to access video streams.
Setup

The AXIS 213 PTZ is configured from the setup tools, which are available from the link in the web interface. The setup tools can be used by:

- **Administrators**, who have unrestricted access to all the Setup tools
- **Operators**, who have access to the Video & Image, Live View Config, and Event Configuration settings.

See the section on *Security - users*, on page 29 for more information on user access control.

Accessing the setup tools from a browser

Follow the instructions below:

1. Start the browser and enter the IP address or host name of the AXIS 213 PTZ in the location/address field.
2. The Live View page is now displayed. Click Setup to display the Setup configuration tools.

**AXIS Media Control**

The AXIS Media Control (AMC) is installed automatically the first time the camera is accessed from Microsoft Internet Explorer. The AMC control panel can be opened by right-clicking on the video image in the Live View page. The AMC control panel can be used to configure various video and audio settings. Please see the readme file included in the tool for more information.
Video & Image

Image

Image Appearance
Use these settings to change the image as required. The image can be rotated, the image resolution and compression can be adjusted, and the white balance can be changed.

The configuration of the video image affects the camera’s overall performance, depending on how it is used and on the available bandwidth. Setting higher resolution and lower compression improves video image quality, but increases the amount of bandwidth required.

Please see the online help for further information on these settings.

Overlay settings
Use these settings to include image, text, date and time overlays.

The text, date and time overlay is included on one line at the top or bottom of the video image. An image can be superimposed over the video image, for extra information.

Follow these instructions to upload and use an overlay image:

1. Go to Setup > Video & Image > Overlay Image.
2. To upload the image to the AXIS 213 PTZ, click the Browse button and locate it on your computer or server.
3. Click the Upload button and follow the on-screen instructions.
4. The image is now available in the Use overlay image drop-down list.
5. Click Save.
6. Go to Setup > Video & Image and modify the parameters under Overlay Settings.

Overlay image requirements

<table>
<thead>
<tr>
<th>Image Formats</th>
<th>Image Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 24-bit BMP (full color)</td>
<td>The height and width of the overlay image in pixels must be exactly divisible by 4.</td>
</tr>
<tr>
<td>Windows 4-bit BMP (16 colors)</td>
<td></td>
</tr>
</tbody>
</table>

There are a number of limitations when using overlay images, such as the size and positioning of images. Please see the online help for more information.

Video Stream
Define the maximum video stream time per session in seconds, minutes or hours. When the set time has expired, a new stream can be started by refreshing the page in the browser.

Define the maximum frame rate (fps - frames per second) allowed for each viewer, to avoid bandwidth problems on the network.

Test
For a preview of the image and overlay settings before saving, click Test. The Brightness setting does not affect the Test image. When satisfied with the settings, click Save. Please note that the preview image is in JPEG format, even though the settings are valid both for Motion JPEG and MPEG-4.
Overlay image
To use your own image as an overlay, it must first be uploaded to the AXIS 213. Enter the name of the file in the field provided, or click the Browse button and locate it. Then click the Upload button.

Once your own image has been uploaded it is available for selection from the drop-down list.

For more information see also the online help.

Advanced - Camera
To optimize the lighting settings according to your requirements, modify the following settings:

Lighting Conditions:
- **White balance** - the white balancing system in the AXIS 213 PTZ can automatically detect white in the image and intelligently use this as a reference for other colors.
- **Exposure control** - this setting is used to adapt to the amount/type of light being used. If set to Manual, select the desired **Shutter speed** from the drop-down list.
- **IR cut filter** - turn the IR filter on or off. To light up the IR lamp on the front of the AXIS 213 PTZ, turn the IR cut filter Off and click **Save**. The **Set IR Lamp** buttons then appear.
- **Use backlight compensation** - this setting is used to make the subject appear clearer against a bright background.

Image Settings
- **Auto focus enabled** (default setting)
- **Noise reduction** - sets the level of noise reduction in the image, that is, sharpens the image. Setting the noise reduction to ‘high’ causes a drop in frame rate (fps).

For more information on all of the above settings, please see the online help.

Notes:
- If configured by the administrator under Live View Config > Layout > IR Buttons, the viewer is able to switch the IR lamp and IR filter on and off directly from the Live View page.
- In certain situations, the white balancing system does not operate effectively. Problems may occur if the image contains no white color at all, or if the dominant color is not white. In these circumstances, the white balance may incorrectly be based on another visible color in the image, and colors may become distorted. A pale background picture with reddish or blue foreground objects is very symptomatic of this condition. In such cases it is recommended that a fixed white balance setting is selected.
Advanced - MPEG-4

Client Compatibility

The AXIS 213 PTZ supports the following different MPEG-4 profiles and levels:

<table>
<thead>
<tr>
<th>Profile@Level</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced Simple Profile @ Level 3</td>
<td>Max bit rate = 768 kbit/s, ISMA compliant</td>
</tr>
<tr>
<td>Advanced Simple Profile @ Level 5</td>
<td>Max Bit rate = 8 Mbit/s</td>
</tr>
</tbody>
</table>

To use Advanced Simple Profile @ Level 3, select ISMA compliant and click the Save button.

Level 5 is preferred if there is enough bandwidth available, as the image quality of the video stream is better than at level 3. The viewing client must support the profile used for the video stream, otherwise the MPEG-4 stream cannot be viewed.

Note: The Axis Media Control supports all the configuration possibilities described on this page.

GOV Settings

The GOV structure can be set to either I or IP, which describes the type of images included in the video stream, as well as their internal order. The IP-structure generally sends the differences compared to the previous image and far fewer complete images, so this method uses much less bandwidth than the I-structure. The I-structure gives higher frame rates when using a high resolution, but requires more bandwidth.

The GOV length determines the sum total of P-images and I-images in a GOV. Setting the GOV length to a high value saves considerably on bandwidth. However there may be noticeable decay in the image at high values.

Notes:

• GOV = Group of VOPs
• VOP = Video Object Plane
• Video Object Plane = image
Bit Rate Control

Limiting the maximum bit rate is a good way of controlling the bandwidth used by the MPEG-4 video stream. Leaving the Maximum bit rate as unlimited provides consistently good image quality, but at the expense of increased bandwidth usage whenever there is more activity in the image. Limiting the bit rate to a defined value prevents excessive bandwidth usage, but images are lost when the limit is exceeded.

Note that a maximum bit rate can be used for both variable and constant bit rates.

The bit rate type can be set as **Variable Bit Rate (VBR)** or **Constant Bit Rate (CBR)**. VBR adjusts the bit rate according to the images’ complexity, thus using a lot of bandwidth for a lot of activity in the image and less for lower activity in the monitored area.
Audio

This section describes how to configure the basic audio settings for the AXIS 213 PTZ such as setting the communication mode and adjusting the sound levels in the microphone and speaker connected to the connection module.

Audio - Basic

Enable Audio

Enable audio transmission to and from the AXIS 213 PTZ using the connection module, which is an optional accessory. See AUDIO IN/OUT, on page 35 for more information.

Audio Channels

There are two mono audio channels between the AXIS 213 PTZ and other clients, one for receiving audio and one for transmitting audio. Each audio channel can be turned on or off, which means that there are four audio mode options that can be used.

Full-duplex mode means that you can transmit and receive audio (talk and listen) at the same time, without having to use any of the controls. This is just like having a telephone conversation. The only controls you may wish to use in this mode are the mute buttons - to turn the sound off, and the sliders - to adjust the input/output volume levels. This mode requires that the client PC has a sound card with support for full-duplex audio. If your available bandwidth is 0.2 Mbit/s or less, it is recommended that you use half-duplex mode instead.

Half-duplex mode also transmits and receives audio in both directions, but only in one direction at a time. This means that you must select when to receive or transmit audio, with the help of the push-to-talk button. To speak, press and hold the button (check that the microphone is not muted). When finished speaking, release the button. You now receive audio from the other end of the connection.

Note that the push-to-talk button is configured from AMC, see AXIS Media Control, on page 12. It is also possible to configure the Push-to-talk button so that it toggles between speaking and listening modes. Half-Duplex mode is best if you only have limited bandwidth available.

When you select Simplex - AXIS 213 PTZ speaker only mode, the speaker connected to the AXIS 213 PTZ's connection module plays audio, but no audio is transmitted from the AXIS 213 PTZ to other web clients. This could be used to provide spoken instructions to a person seen in the network camera. This mode requires you to use the push to talk button.

Simplex - AXIS 213 PTZ microphone only mode transmits audio from the microphone connected to the AXIS 213 PTZ's connection module to any web clients. It does not receive audio from any other web clients. This can be used in remote monitoring, web attractions etc., to provide live audio, as well as video, of a monitored situation.
When using half-duplex, the **Send the sound from the active client to all other clients** option transmits the audio signal from the client that is talking to all the other clients.

**Audio Input**

If there are problems with the sound input being too low or high, it is possible to adjust the input gain for the microphone connected to the AXIS 213 PTZ.

**Audio Output**

If the sound from the speaker is too low or high it is possible to adjust the output gain for the active speaker connected to the connection module.

When satisfied with the settings, click **Save**, or click **Reset** to revert to the previously saved settings.

**Audio - Advanced**

The advanced audio settings allows you to tune the external microphone connected to the AXIS 213 PTZ connection module to suit your environment.

Audio Quality Settings

Enable speech filter improves the sound quality when the microphone is placed close to the person talking and can also help reduce background noise. The filter cuts the lowest and the highest frequencies. The bypass frequency range is approximately 250Hz to 3700Hz (measured at -10dB cut-off break points).

Enable echo cancellation reduces acoustic echoing if sound from the speaker is captured by the microphone.

Noise canceling is a way of reducing the background noise when there is no useful audio present. A typical application could be that the camera is set up in a noisy environment, and you are only interested in hearing the sound from the AXIS 213 PTZ when someone is speaking close to the microphone. There are two adjustable parameters available to optimize this function:

- **Noise canceller threshold value**
- **Noise canceller attenuation**

When the incoming sound is louder than the threshold, it passes without any changes. When lower than the threshold, the incoming sound is reduced by a certain attenuation factor. The threshold level should be set higher than the background noise, but lower than the useful audio.

The **noise canceller threshold value** can be set to **High**, **Medium High**, **Medium low** and **Low**. A lower threshold accepts most of the audio to pass. Only the weakest background noise is reduced. A higher threshold makes the noise canceller act on even stronger background noise. At the maximum level **High**, there is a risk of reducing useful audio as well.

There is a trade-off between noise canceling and sound quality. In other words, increasing the **noise canceller attenuation** deteriorates sound quality. Adjust the threshold and the attenuation to an optimum by listening and changing the levels.
**Live View Config**

### Live View Layout
These are the tools for deciding the layout of the Live View page. The layout can be set in 3 ways:

- **Use Axis look** - the layout is unchanged.
- **Use custom settings** - modify the default page with your own colors, images etc. Click the **Configure** button and see the following page.
- **Own Home Page** - Upload and use a custom page as the default web page. Click the **Configure** button and see below.

#### Use custom settings
Adjust the settings under **Modify the Axis look**, to change the background picture, banner, colors, etc.

To use your own file for a banner, check the Own radio button and select your own uploaded file from the drop-down list, or select **External** and enter the path to the file. See below for instructions on uploading your own files.

#### Own Home Page
To use a previously uploaded web page (see below) as the default page, check the checkbox, select the page from the drop-down list and click **OK**.

#### Upload Own Web Files
Your own web files, background pictures etc., must first be uploaded to the AXIS 213 PTZ in order to be available for selection in the Custom Settings setup dialog. Once uploaded, the files are shown in the drop-down list.

1. Enter the path to the file, or click the **Browse** button.
2. Select the user level for the uploaded file. Setting the user access level means that you have complete control over which pages can be viewed by which users.
3. When the path is shown correctly in the text field, click the **Upload** button.

All uploaded files are shown in the list in the lower section of the page. To remove a file, check the box provided next to it and then click the **Remove** button.

**Note:** Unchecking the box for Show setup link removes the setup link from the camera’s Home Page. The setup tools are then only accessible by entering the full setup address into the address/URL field of a browser, that is, http://<ipaddress>/operator/basic.shtml
User Defined Links
Enter a descriptive name and enter the URL in the provided field. The link appears on the Live View page. User defined CGI links can be used to issue HTTP API requests, such as PTZ commands.

Example:

1. Check Show custom link 1
2. Enter a descriptive name, such as CAM START.
3. Select the Use as cgi link radio button and enter the cgi link in the field:
   ```
   ```
4. Check Show custom link 2.
5. Enter a descriptive name, such as CAM STOP.
6. Select the Use as cgi link radio button and enter the cgi link in the field:
   ```
   http://192.168.0.125/axis-cgi/com/ptz.cgi?continuouspantiltmove=0,0
   ```
7. These links appear in the web interface and can be used to control the PTZ camera.

For more information on the Axis HTTP API, see the Support / Developer pages on the Axis Website at http://www.axis.com

Action Buttons
These buttons can then be used to manually trigger and stop an event from the Live View page. See Event Servers, on page 25.

The snapshot button allows users to take a snapshot of the video stream and save it on a computer.

Output Buttons
These buttons can then be used to manually start and stop an event from the Live View page, such as switching a light on/off:

- The Pulse button activates the port for a defined period
- Active/Inactive displays 2 buttons, one for each action (on/off)

Default Video Format
Select default video format from the drop-down list. Check the box to enable video format selection on the Live View Page.
Default Viewer
Select your preferred method of viewing moving images. The options are:

<table>
<thead>
<tr>
<th>Browser</th>
<th>Viewer</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Internet Explorer</td>
<td>AMC</td>
<td>Recommended viewer in Windows Internet Explorer (MPEG-4 /Motion JPEG). Might not be possible on computers that have restrictions on the installation of additional software.</td>
</tr>
<tr>
<td></td>
<td>QuickTime</td>
<td>MPEG-4 only.</td>
</tr>
<tr>
<td></td>
<td>Java applet</td>
<td>A slower imaging alternative to AMC. Requires one of the following installed on the client:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• JVM (J2SE) 1.4.2 or higher</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• JRE (J2SE) 5.0 or higher</td>
</tr>
<tr>
<td></td>
<td>Still image</td>
<td>Displays still images only. Hit the Refresh button in your browser to view a new image.</td>
</tr>
<tr>
<td>Other browsers</td>
<td>Server Push</td>
<td>Recommended viewer for other browsers (Motion JPEG).</td>
</tr>
<tr>
<td></td>
<td>QuickTime</td>
<td>MPEG-4 only.</td>
</tr>
<tr>
<td></td>
<td>Java applet</td>
<td>A slower imaging alternative to Server Push (Motion JPEG only).</td>
</tr>
<tr>
<td></td>
<td>Still image</td>
<td>Displays still images only. Hit the Refresh button in your browser to view a new image.</td>
</tr>
</tbody>
</table>

Please see the online help 🔄 for more information.

Viewer settings
Show viewer toolbar - uncheck to remove the viewer toolbar from the Live View page.

Enable MPEG-4 decoder installation - enables/disables the installation of the MPEG-4 decoder included with AMC.

Show crosshair in PTZ joystick mode- enables/disables a red position indicator on the Live View page when the joystick navigation mode is selected.

HTML Examples
You can add live video from the AXIS 213 PTZ to your own web site. The camera can transmit a Motion JPEG stream to up to 20 simultaneous connections, although an administrator can restrict this to fewer.

Select the preferred Video Format from the drop down list. The available options are Motion JPEG, MPEG-4 using AMC and MPEG-4 using QuickTime. If MPEG-4 is set as the video format, note that a separate MPEG-4 license is required for each viewer.

The Motion JPEG selection has additional settings for Image Type, Image size and other optional settings to configure the video stream to suit your Web page. Click Update once satisfied.

The camera generates the required source code for your configuration. Copy this code and paste it into your own Web page code.

External Video
The AXIS 213 PTZ can also display video images from other Axis network cameras and video servers, directly on the Live View page. These are known as External Video sources. Once configured, these external video sources are available from the drop-down list on the Live View page.

Click the Add button to open the External Video Source Setup dialog, which is used to make all the necessary settings. Enter the IP address or host name of the external video source you wish to add. Depending on the external source, select either MPEG-2, MPEG-4 or Motion JPEG as the type of video stream to receive.
PTZ Configuration

Preset Positions
A preset position is a pre-defined camera view than can be quickly and easily moved to and viewed, simply by selecting the preset.

From Preset Position Setup, use the Pan, Tilt and Zoom (PTZ) controls to steer the camera to the required position. When satisfied with the camera’s position, enter a descriptive name. This camera position is then saved as a preset position.

The AXIS 213 PTZ assumes the exact position when the preset’s name is selected - from the Preset positions drop-down list on the Live View page, or by events or Sequence modes (see below).

Any one position can be set as the Home position, which is readily accessible by clicking on the Home button in both the Preset Position Setup window and the Live View window. The position’s name has (H) added, for example, Office Entrance (H).

Sequence Mode
The Live View page can be configured to rotate through selected preset positions, in a set order or randomly. External video sources can also be included in these sequences.

Select the desired preset positions and/or external video sources and enter the time to display each position. Click Save.

The Sequence buttons appear on the Live View page - to enable the viewer to start and stop the sequence mode.

Advanced - Limits
Define the pan, tilt and zoom limits for the AXIS 213 PTZ. Movements to the left and right, up and down can be restricted to narrow the area under surveillance. See the online help for more information.

Advanced - Ctrl Panel
This allows you to add shortcut command buttons to the control panel. This requires the URL (path) to an auxiliary command provided by the PTZ driver, or to some other command accessed via the HTTP API. See the online help for more information.

Advanced - Calibration
The area zoom functionality available on the Live View page can be calibrated from here.

Advanced - Control Queue
PTZ Control Queue - the administrator can set up a queue for the PTZ controls. Once set up, the PTZ Control Queue buttons appear on the Live View page offering one viewer exclusive control for a limited amount of time. Other users are placed in the queue. See the online help for more information.
Event Configuration

This section describes how to configure the AXIS 213 PTZ for alarm and event handling. The AXIS 213 PTZ can be configured to perform certain actions when certain types of events occur.

Terminology

- **Event Type** - a set of parameters describing the network camera. An event type may result in a single *event*, or in many, depending on how often the conditions governing its behavior apply.
- **Triggered Event Type** - an event that is activated by a specific internal or external trigger condition. For example by motion detection or by an external device such as a door switch or a sensor.
- **Scheduled Event Type** - an event that runs at a pre-programmed time.
- **Action** - what occurs when the event triggers an action, such as the upload of video images to an FTP server, email notification, and so on.

Event Servers

Event Servers are used, for receiving uploaded image files and/or notification messages for example. To set up Event server connections in your AXIS 213 PTZ, go to **Setup > Event Configuration > Event Servers** and enter the required information according to the selected server type.

<table>
<thead>
<tr>
<th>Server type</th>
<th>Purpose</th>
<th>Required information</th>
</tr>
</thead>
</table>
| FTP server | • Upload of saved images | • IP address/hostname  
• Descriptive name of your choice  
• User name and password (to FTP server)  
• Upload path  
• Port number  
• Use passive mode if there is a firewall between the camera and the FTP server |
| HTTP server | • Notification messages  
• Upload of saved images | • Descriptive name of your choice  
• URL  
• User name and password (to HTTP server)  
• Proxy address/proxy port  
• Proxy user name and password |
| TCP server | | • IP address/hostname  
• Descriptive name of your choice  
• Port number |

For details on each setting, please refer to the online help files available from each web page.

**Note:** Pre-trigger and Post-trigger buffers are lost if the connection to the event server fails.

When the setup is complete, the connection can be tested by clicking the **Test** button (the connection test takes approximately 10 seconds).
Event Types

An Event Type is a set of parameters describing how and when the AXIS 213 PTZ is to perform certain actions. The Event Type List shows the event types currently configured in the camera.

Example:

- If somebody passes a connected sensor and an event type has been configured to act on this, the camera can record and save images to an FTP server, and/or send a notification email to a pre-configured email address with a pre-configured message. Images can be sent as email attachments.

Triggered Event

A triggered event can be activated by, for example:

- a switch connected to an input port on connection module attached to the AXIS 213 PTZ
- a manually activated action from an action button in the web interface
- on restart (reboot) after power loss.

Setting up a triggered event

This example describes how to configure the AXIS 213 PTZ to upload images when the main door is opened:

1. Click Add triggered on the Event types page.
2. Enter a descriptive name for the event, such as Main door.
3. Set the Priority - High, Normal or Low (see online help files).
4. Set the Respond to Trigger... parameters defining when the event is to be active, such as, only after office hours.
5. Select the trigger alternative from the Triggered by... drop-down list, such as an Input port with a connected sensor if the door is opened.
6. Set the When Triggered... parameters, that is, define that if the main door is opened AXIS 213 PTZ upload images to an FTP server or sends an e-mail.
7. Click OK to save the Event in the Event Types list.

Please see the online help for descriptions of each option. Image file names can be formatted according to specific requirements, such as time/date or type of triggered event. See File Naming & Date/Time Formats, under Event Configuration.

Pre-trigger and Post-trigger buffers

This function is useful for checking what happened before and after a trigger, such as two minutes before and after a door has been opened. Check the Upload images checkbox under Event Types > Add Triggered... > When Triggered... to expand the web page with the available options.

Note:

- The buffer size is up to 9 MB buffer. The maximum length of time of the pre-/post-buffer depends on the image size and selected frame rate.
Include pre-trigger buffer - images stored internally in the server from the time immediately preceding the trigger. Check the box to enable the pre-trigger buffer, enter the desired length of time and specify the required image frequency.

Include post-trigger buffer - contains images from the time immediately after the trigger. Configure as for pre-trigger.

Note: If the pre- or post-buffer is too large for the internal memory, the frame rate is reduced and individual images may be missing. If this occurs, an entry is created in the unit's log file.

Continue image upload (unbuffered) - enable the upload of images for a fixed length of time. Specify the length of time for the uploaded recording, in seconds, minutes or hours, or for as long as the trigger is active. Finally, set the desired image frequency to the maximum (the maximum available) or to a specified frame rate. The frame rate would be the best possible, but might not be as high as specified, especially if uploading via a slow connection.

Scheduled Event
A Scheduled event can be activated at pre-set times, in a repeating pattern on selected weekdays.

Setting up a scheduled event
This example describes how to set the AXIS 213 PTZ to send an email notification with saved images from a set time:

1. Click Add scheduled on the Event types page.
2. Enter a descriptive name for the event, such as Scheduled email.
3. Set the Priority (High, Normal or Low).
4. Set the Activation Time parameters (24h clock) when the event is to be active (such as starting on Fridays at 18.00 with a duration of 62 hours).
5. Set the When Activated... parameters that is, set what the AXIS 213 PTZ is to do at the specified time (send uploaded images to an email address).
6. Click OK to save the Event in the Event Types list.

Please see the online help files for descriptions of each available option.

Motion Detection
In the Motion Detection menu, you can configure the AXIS 213 PTZ for motion detection. The motion detection feature is used to generate an alarm whenever movement occurs (or stops) in the image. The AXIS 213 PTZ can use a maximum of 10 Include/Exclude windows.

• Include windows target specific areas within the image
• Exclude windows are areas to be ignored within the Include window

Once configured, the motion detection windows appear in a list when motion detection is selected to trigger an event. See Setting up a triggered event above.

Note: • Using the motion detection feature may decrease overall performance in the camera.
• Motion detection will not function while the lens is moving (pan, tilt, zoom)

Configuring motion detection
This example describes how to configure motion detection:

1. Click Motion Detection in the Event Configuration menu.
2. Click the Configure Included Windows radio button.
3. Click New.
4. Enter a descriptive name of your choice under Windows name.
5. Adjust the size (drag the bottom right-hand corner) and position (click on the text at the top and drag to the desired position).
6. Adjust the Object size, History and Sensitivity profile sliders (see table below for details). Any detected motion within an active window is then indicated by red peaks in the Activity window (the active window has a red frame).

7. Click Save.

If there are parts of the Include window that you wish to exclude, click the Configure Excluded Windows radio button and repeat steps 1-8 above.

Please see the online help for descriptions of options.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Size</th>
<th>History</th>
<th>Sensitivity</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>Only very large objects trigger motion detection</td>
<td>An object that appears in the region triggers the motion detection for a long period</td>
<td>Ordinary colored objects against ordinary backgrounds trigger the motion detection</td>
</tr>
<tr>
<td>Low</td>
<td>Even very small objects trigger motion detection</td>
<td>An object that appears in the region triggers motion detection for only a very short period</td>
<td>Only very bright objects against a dark background trigger motion detection</td>
</tr>
<tr>
<td>Default values</td>
<td>Low</td>
<td>Medium to High</td>
<td>Medium to High</td>
</tr>
</tbody>
</table>

Examples:

- Avoid triggering on small objects in the image by selecting a high size level.
- To trigger motion detection as long as there is activity in the area, select a high history level.
- To only detect flashing light, low sensitivity can be selected. In other cases, a high sensitivity level is recommended.

Port Status

Under Event Configuration > Port Status there is a list that shows the status for the connected inputs and outputs of the AXIS 213 PTZ for the benefit of the Operator who cannot access the System Options section.

Example: If the Normal state for a push button connected to an input is set to Inactive - as long as the button is not pushed, the state is inactive. If the button is pushed, the state of the input changes to active.
System Options

Security - users
User access control is enabled by default; the administrator sets the root password on first access. Other users are authorized with user names and passwords, or the administrator can choose to allow anonymous viewer login to the Live View page, described below:

User List
The user list displays the currently configured authorized users and their access levels:

- **Viewer** - the lowest level of access, which only allows the user access to the Live View page.
- **Operator** - an operator can view the Live View page, create and modify event types and adjust certain other settings. The operator does not have access to the Systems Options configuration pages.
- **Administrator** - an administrator has unrestricted access to the Setup Tools and can determine the registration of all other users.

User Settings
Check the required boxes to enable the following functions:

- **Enable anonymous viewer login** - allows any viewer direct access to the Live View page.
- **Maximum number of simultaneous viewers** - enter a value here to restrict the number of unicast viewers accessing the unit. This is useful if you need to save on bandwidth. (Note that all multicast viewers count as 1 viewer.)
- **Enable anonymous PTZ control login** - allows any viewer access to the Pan/Tilt/Zoom controls on the Live View page.

Security - IP Address Filter

General
Enable IP Address Filtering - when enabled, the IP address filter allows or denies access to the AXIS 213 PTZ to the IP addresses in the list. The administrator can add up to 256 IP address ranges or single IP addresses to the **Allowed IP Addresses** list.

See the IP address filtering help files for information on how to add IP address ranges.

Referrals
To prevent unauthorized sources from including the video stream from the AXIS 213 PTZ into external web pages, check the **Referrals** checkbox and enter the IP address or Host name of the allowed computer(s) that host the web pages with the included video stream. Several IP addresses/host names can be defined and should be separated by semicolons(;)

Date & Time Settings

Current Server Time
Displays the current date and time (24h clock). If this has not been configured, the time displayed is the default setting. The time can be displayed in 12h clock format in the Overlay Images (see below).

New Server Time - Select your time zone from the drop-down list and check the daylight saving time changes, if desired.
From the **Time Mode** section, select the preferred method to use for setting the time:

- **Synchronize with computer time** - sets the time from the clock on your computer.
- **Synchronize with NTP Server** - the AXIS 213 PTZ obtains the time from an NTP server every 60 minutes. Specify the NTP server’s IP address or host name.
  Note that if using a host name for the NTP server, a DNS server must be configured under TCP/IP settings. See Network > TCP/IP below.

**Set manually** - this option allows you to manually set the time and date.

**Date & Time Format Used in Images** - specify the formats for the date and time (12h or 24h) displayed in the Live View video streams.

Use the predefined formats or use your own custom date and time formats. See [Advanced File Naming & Date/Time Formats](#) in the help files for information on how to create your own file formats.

**Network - Basic TCP/IP Settings**

**IP Address Configuration**
The IP address of the AXIS 213 PTZ can be set automatically via DHCP, or a fixed IP address can be set manually. A host name can be used and there are options for setting up notification of changes in the IP address. DHCP is enabled by default.

**Note:**
- Automatic IP address assignment via DHCP may lead to the situation where the IP address is changed and you lose contact. Configure the options for notification of IP address change (under Services) to receive notification from the AXIS 213 PTZ, when the IP address has been changed.
- Alternatively, if your DHCP server can update a DNS server, you can access the AXIS 213 PTZ by host name which is always the same, regardless of the IP address.

**Services**
Options for notification of IP address change - if the IP Address for the AXIS 213 PTZ is changed automatically, by DHCP for example, you can choose to be notified. Click Settings... and enter the required information.

**AXIS Internet Dynamic DNS Service** - If the AXIS 213 PTZ has been registered with the Axis Internet Dynamic DNS service and the IP address for the product changes, the service is updated to reflect the change. Check the box to enable/disable automatic updates.

The domain name currently registered at the Axis Internet Dynamic DNS service for your product can at any time be removed. To do this click Settings... and follow the instructions.

For more information, please refer to the online help files

**Network Advanced TCP/IP Settings**

**DNS Configuration**
DNS (Domain Name Service) provides the translation of host names to IP addresses on your network.

**Obtain DNS server address via DHCP** - automatically use the DNS server settings provided by the DHCP server. Click the View button to see the current settings.

**Use the following DNS server address** - enter the desired DNS server by specifying the following:

- **Domain name** - enter the domain(s) to search for the host name used by the AXIS 213 PTZ. Multiple domains can be separated by semicolons (;). The host name is always the first part of a Fully Qualified Domain Name. For example myserver is the host name in the Fully Qualified Domain Name myserver.mycompany.com where mycompany.com is the Domain name.
- **Primary DNS server** - enter the IP address of the primary DNS server.
- **Secondary DNS server** - is used if the primary DNS server is unavailable.
NTP Configuration
The AXIS 213 PTZ can obtain the correct time from an NTP server. The address for the NTP server can either be obtained via the DHCP server, or it can be entered manually.

Host Name Configuration
The AXIS 213 PTZ can be accessed using a host name, instead of an IP address. The host name is usually the same as the assigned DNS Name. It is always the first part of a Fully Qualified Domain Name and is always one word, with no period. For example, myserver is the host name in the Fully Qualified Domain Name myserver.mycompany.com.

The enable dynamic DNS updates allows you to alias a dynamic IP address to a static host name, allowing your computer to be more easily accessed from various locations on the Internet. Outside users can always access your server using the associated DNS name regardless of the WAN IP. The DNS server used by the user and/or the DNS server responsible for the domain in use must support RFC2136 and allow updates from the camera.

The TTL (Time To Live) value determines how long (in seconds) the reply from the DNS server should be remembered when checking that the domain name for the registered IP address is still valid.

Link-Local Address
Link-Local Address is enabled by default and assigns the AXIS 213 PTZ an additional IP address for the UPnP protocol. The AXIS 213 PTZ can have both a Link-Local IP and a static/DHCP IP address at the same time - these do not affect each other. See Network - UPnP, on page 32.

HTTP
The default HTTP port number (port 80) can be changed to any port within the range 1024-65535. This is useful for simple security port mapping, for example.

NAT Traversal
Use NAT traversal when your AXIS 213 PTZ is located on an intranet (LAN) and you wish to make it available from the other (WAN) side of a NAT router. With NAT traversal properly configured, all HTTP traffic to an external HTTP port in the NAT router is forwarded to the network camera.

Enable/Disable - when enabled, the AXIS 213 PTZ attempts to configure port mapping in a NAT router on your network, using UPnP™.

Use manually selected NAT router - select this option to manually select a NAT router. Enter the IP address for the router in the field provided.
If a router is not manually specified, the AXIS 213 PTZ Network Camera automatically searches for NAT routers on your network. If more than one router is found, the default router is selected.

Alternative HTTP port - select this option to manually define an external HTTP port. Enter the port number in the field provided. If no port is entered here a port number is automatically selected when NAT traversal is enabled.

RTSP
The RTSP protocol allows a connecting client to start an MPEG-4 stream. Enter the RTSP port number to use. The default setting is 554.

Network Traffic
The default setting is Auto-negotiate which means that the correct speed is automatically selected. If necessary, you can set the connection speed by selecting it from the drop-down list. 10BaseT (Half/Full Duplex), 100BaseTX (Half/Full Duplex).

Maximum bandwidth - Specify, in Mbit/s or Kbit/s, the maximum bandwidth that the AXIS 213 PTZ is allowed to use on your network. This is a useful function when connecting the AXIS 213 PTZ to busy or heavily loaded networks. The default setting is Unlimited.

For more information, please refer to the online help files 🌐
Network - SOCKS

SOCKS is a networking proxy protocol. The AXIS 213 PTZ can be configured to use a SOCKS server to reach networks on the other side of a firewall/proxy server. This functionality is useful if the AXIS 213 PTZ is located on a local network behind a firewall, but notifications, uploads, alarms, need to be sent to a destination outside the local network (to the Internet).

Network - SMTP (email)

(Simple Mail Transfer Protocol) Enter the host names or addresses for your primary and secondary mail servers in the fields provided to enable event and error email messages from the AXIS 213 PTZ to predefined addresses, via SMTP.

Network - UPnP

The AXIS 213 PTZ includes support for UPnP in Windows Millennium and Windows XP. UPnP is enabled by default.

Note: UPnP must be installed on your workstation. To do this, open the Control Panel from the Start Menu and select Add/Remove Programs. Select Add/Remove Windows Components and open the Networking Services section. Click Details and then select UPnP as the service to add.

Network - RTP/MPEG-4

These RTP settings concern the IP addresses and port numbers to use for video and audio streams, and are only valid when MPEG-4 is used as the video format.

Port Range
The RTP Port range defines the range of ports from which the video/audio ports are automatically selected. This is useful if the camera is connected to a NAT router with manually configured port mapping.

Multicast
Set the IP addresses and port numbers, and the Time-To-Live value to use for the video and audio stream(s) in MPEG-4 format.

Only IP addresses within certain ranges can be used for multicasting. The camera has been pre-configured with an address from these ranges, and this does not normally need to be changed. Please contact your network administrator if you have special requirements.

Notes: • Viewers do not need to know this IP address or port number, but simply the main IP address or host name otherwise used for accessing the camera.
• Setting the video port number to 0 means a random port number will be used.
For more information on these settings, please see the online help.

Network - Bonjour

The AXIS 213 PTZ includes support for Bonjour. When this is enabled, the camera is automatically detected by operating systems and clients that support this protocol.

Ports & Devices

The pinout, interface support and the control and monitoring functions are described in the section on the Connection Module, on page 35.
Ports & Devices - LED Settings

When the LED on the front of the AXIS 213 PTZ is Enabled, the LED is lit when the AXIS 213 PTZ is on and flash when there is any network activity. If Disabled, the LED is off, except when there is a hardware problem and the LED will flash red.

Ports & Devices - Maintenance

Maintain Server

- **Restart** - The unit is restarted without changing any of the settings. Use this method if the unit is not behaving as expected.
- **Restore** - The unit is restarted and most current settings are reset to factory default values. The settings that will not be reset are as follows:
  - the boot protocol (DHCP or static)
  - the static IP address
  - the default router
  - the subnet mask
  - the system time
- **Default** - The Factory default button should be used with caution. Pressing this button will reset all of the AXIS 213 PTZ’s settings to the factory default values (including the IP address)

Upgrade Server

See *Upgrading the Firmware*, on page 37.

Backup

Click the Backup button to take a backup of all of the parameters, and user-defined scripts. It will then be possible to return to the previous settings if the settings are changed and there is unexpected behavior.

**Note:** The root password will also be reset to the password saved in the backup file.

Restore

Click the Browse button to locate the saved backup file (see above) and then click the Restore button. The settings will be restored to the previous configuration.

**Note:** Backup and Restore can only be used on the same unit running the same firmware. This feature is not intended for multi-configurations or for firmware upgrades.

Support - Support Overview

The support overview page provides valuable information on troubleshooting and contact information, should you require technical assistance.

Support - System Overview

This provides a quick look at the status and settings for the camera. Information that can be found here includes the camera’s firmware version, IP address, security, event and image settings, as well as recent log items. Many of the captions are also links to the Setup pages, so that you can quickly and easily make adjustments to the camera’s settings.

Support - Logs & Reports

Information

The Logs, Server report and the Parameter List provide valuable information for troubleshooting and when contacting Axis’ support service. Please include a recent Server Report with your query when contacting Axis support.
Configuration

- **Log Level for Log Files** - from the drop-down list, select the level of information to be added to the Log file.
- **Log Level for Email** - from the drop-down list, select the level of information to send as email and enter the destination email address.

**Advanced – Scripting**

Scripting is an advanced function that enables customizing and using scripts. This function is a very powerful tool.

**Caution!**
Improper use may cause unexpected behavior or even cause loss of contact with the unit. If a script does cause problems, reset the unit to its factory default settings. A backup file may be of use to return the unit to its latest configuration.

Axis recommends that you do not use this function unless you fully understand the consequences. Axis support does not provide assistance for problems with customized scripts.

For more information, please visit the Developer pages at www.axis.com/developer

**Advanced – Plain Config**

This function is for the advanced user with experience of Axis network camera configuration. All parameters can be set and modified from this page. Help is available from the standard help pages.

**Resetting to Factory Default Settings**

To reset the AXIS 213 PTZ to the original default settings, go to the System Options > Maintenance web page (described in Ports & Devices - Maintenance, on page 33)

-or- use the Reset button on the AXIS 213 PTZ as described below:

**Using the Reset Button**

Follow the instructions below to reset the AXIS 213 PTZ to factory default settings using the Reset Button.

1. Switch off the AXIS 213 PTZ by disconnecting the external power supply.
2. Using a suitably pointed object, press and hold the Reset button while you reconnect the power connector.
3. Keep the Reset button pressed for approximately 15 seconds.
4. Release the Reset button.

**Note:** Resetting to the factory default settings using the Reset Button will cause all parameters (including the IP address) to be reset. Refer to Ports & Devices - Maintenance, on page 33 for other methods that do not reset the IP address.
Connection Module

The connection module is an optional accessory configured and controlled via the camera user interface. When connected to the camera it provides the following connections:

- SERVER - for the connection to the AXIS 213
- 2 Digital inputs
- VIDEO IN
- RS-232C serial port
- AUDIO IN/OUT
- 3 Relay outputs
- VIDEO OUT

AUDIO IN/OUT

1. Connect an electret microphone (not supplied) to the AUDIO IN socket.
2. Connect a loudspeaker (not supplied) to the AUDIO OUT socket (amplified speakers only).

Inputs and outputs (I/Os)

The I/Os are used in applications for event triggering, time lapse recording, alarm notification via email, and image storage to FTP locations, for example.

- **Input** - for a pushbutton. If the button is pressed, the state changes, and the input is active (shown under Event Configuration > Port Status).
- **Output** - for an alarm device that can be activated from output buttons on the Live View page, or as an action for an Event Type. If the alarm device is activated, the output shows as active (under Event Configuration > Port Status).

<table>
<thead>
<tr>
<th>I/O</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm In 1,2</td>
<td>Connect to GND to activate, or leave floating (unconnected) to deactivate.</td>
</tr>
<tr>
<td>Alarm GND</td>
<td></td>
</tr>
<tr>
<td>Alarm Out 1A,1B;2A,2B;3A,3B</td>
<td>Active output, electrical connection between A and B. Non-active output, no connection between A and B. I_{max}=100mA, V_{max}=24V</td>
</tr>
</tbody>
</table>

VIDEO IN

This input can be used to connect an external analog camera. It is then possible to display images from this camera in the AXIS 213’s web pages.

Only one image source at a time can be displayed. This is selected from System Options > Advanced > Plain Config. Open the group ImageSource and then set the ImageSource IO Video Connector to BNC for the external camera. Setting this to YC will instead show the images from the AXIS 213 itself.

VIDEO OUT

Via the standard BNC connector, this output allows the AXIS 213 to be connected directly to a traditional CCTV system. Note that to display the image from VIDEO OUT with the correct orientation, the AXIS 213 must be ceiling mounted.

RS-232C

This port can be used for generic TCP/IP or HTTP communication, and is intended for use by advanced applications and users only. The port can configured in the Serial group (set Port 1 Usage to the required protocol) in System Options > Advanced > Plain Config.
Schematic Diagram - Connection Module

- +3.3 V connected to Alarm In 1
- Alarm In 1 connected to Alarm In 1 GND
- Alarm In 2 connected to Alarm In 2 GND

- +3.3 V connected to Alarm Out 1A
- Alarm Out 1A connected to Alarm Out 1B
- Alarm Out 1B connected to Alarm Out 2A
- Alarm Out 2A connected to Alarm Out 2B
- Alarm Out 2B connected to Alarm Out 3A
- Alarm Out 3A connected to Alarm Out 3B

- e.g. push button connected to Alarm In 1 GND
Troubleshooting

Checking the Firmware
Firmware is software that determines the functionality of the AXIS 213 PTZ. One of your first actions when troubleshooting a problem should be to check the firmware version. The latest version may contain a correction that fixes your particular problem. The current firmware in your camera can be viewed on the page Setup > Basic Configuration.

Upgrading the Firmware
When you upgrade the firmware with a file from the Axis website, your camera receives the latest available functionality. Always read the upgrade instructions and release notes available with each new release, before updating the firmware.

Note: Preconfigured and customized settings will be saved when the firmware is upgraded (providing the features are available in the new firmware) although this is not guaranteed by Axis Communications. Always read the instructions and release notes available with each new release, before upgrading the firmware.

1. Save the firmware file to your computer. The latest version of the firmware is available free of charge from the Axis Web site at www.axis.com/techsup.
2. Go to Setup > System Options > Maintenance in the camera’s web pages.
3. In the Upgrade Server section, browse to the desired firmware file on your computer. Click Upgrade.

Notes:
• After starting the upgrade process, always wait at least 5-10 minutes before restarting the camera, even if you suspect the upgrade has failed.
• Your dealer reserves the right to charge for any repair attributable to faulty upgrading by the user.
• The AXIS Camera Management software tool can be used for multiple upgrades. Please see the Axis Web site at www.axis.com for more information.
Support

If you contact the Axis support desk, help us help you resolve your problems by providing a server report, log file and a brief description of the problem.

Server Report - go to Setup > System Options > Support Overview. The server report contains important information about the server and its software, as well as a list of the current parameters.

Log file - go to Setup > System Options > Logs & Reports. The Log file records events within the unit since the last restart of the system and can prove a useful diagnostic tool for troubleshooting.
## Symptoms, Possible Causes and Remedial Actions

<table>
<thead>
<tr>
<th>Problems setting the IP address</th>
<th>Remedial Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>When using ARP/Ping</td>
<td>Try the installation again. The IP address must be set within two minutes after power has been applied to the camera. Ensure the Ping length is set to 408. See the Installation Guide.</td>
</tr>
<tr>
<td>The camera is located on a different subnet</td>
<td>If the IP address intended for the camera and the IP address of your computer are located on different subnets, you will not be able to set the IP address. Contact your network administrator to obtain an appropriate IP address.</td>
</tr>
<tr>
<td>The IP address is being used by another device on the same subnet</td>
<td>Disconnect the camera from the network. Run the Ping command. (In a Command/DOS window, type <code>ping</code> and the IP address of the unit). If you receive: <code>Reply from &lt;IP address&gt;: bytes = 32; time = 10 ms....</code> - this means that the IP address may already be in use by another device on your network. You must obtain a new IP address and reinstall the unit. If you see: <code>Request timed out</code> - this means that the IP address is available for use with your camera. In this case, check all cabling and reinstall the unit.</td>
</tr>
<tr>
<td>Possible IP address conflict with another device on the same subnet</td>
<td>The static IP address in the camera is used before the DHCP server sets a dynamic address. This means that if the same default static IP address is also used by another device, there may be problems accessing the camera. To avoid this, set the static IP address to 0.0.0.0.</td>
</tr>
<tr>
<td>The camera cannot be accessed from a browser</td>
<td>1) Move the camera to an isolated network or to one with no DHCP or BOOTP server. Set the IP address again, using the AXIS IP Utility (see the Installation Guide) or the ARP/Ping commands. 2) Access the unit and disable DHCP in the TCP/IP settings. Return the unit to the main network. The unit now has a fixed IP address that will not change. 3) As an alternative to 2), if dynamic IP address via DHCP or BOOTP is required, select the required service and then configure IP address change notification from the network settings. Return the unit to the main network. The unit will now have a dynamic IP address, but will notify you if the address changes.</td>
</tr>
<tr>
<td>Other networking problems</td>
<td>Test the network cable by connecting it to another network device, then Ping that device from your workstation. See the instructions above.</td>
</tr>
</tbody>
</table>

### Camera is accessible locally, but not externally

| Broadband router configuration | To configure your broadband router to allow incoming data traffic to the camera: Enable the NAT-traversal feature which will attempt to automatically configure the router to allow access to the camera. This is enabled from Setup > System Options > Network > TCP/IP Advanced. |
| Firewall protection | Check the Internet firewall with your system administrator. |
| Default routers required | Check if you need to configure the default router settings. |

### Problems with the MPEG-4 format

<p>| No MPEG-4 displayed in the client | Check that the correct network interface is selected in the AMC control panel applet (network tab). Check that the relevant MPEG-4 connection methods are enabled in the AMC control panel applet (network tab). In the AMC control applet, select the MPEG-4 tab and click the button Set to default MPEG-4 decoder. |
| No multicast MPEG-4 displayed in the client | Check with your network administrator that the multicast addresses used by the camera are valid for your network. Check with your network administrator to see if there is a firewall preventing viewing. |
| Multicast MPEG-4 only accessible by local clients | Check if your router supports multicasting, or if the router settings between the client and the server need to be configured. The TTL (Time To Live) value may need to be increased. |
| Poor rendering of MPEG-4 images | Color depth set incorrectly on clients. Set to 16-bit or 32-bit color. If text overlays are blurred, or if there are other rendering problems, you may need to enable Advanced Video Rendering from the MPEG-4 tab in the AMC control panel applet. Ensure that your graphics card is using the latest device driver. The latest drivers can usually be downloaded from the manufacturer's web site. |
| Color saturation is different in MPEG-4 and Motion JPEG | Modify the settings for your graphics adapter. Please see the adapter's documentation for more information. |</p>
<table>
<thead>
<tr>
<th>Issue</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lower frame rate than expected</td>
<td>Reduce number of applications running on the client computer.</td>
</tr>
<tr>
<td></td>
<td>Limit the number of simultaneous viewers. This is done in System Options &gt; Security &gt; Users.</td>
</tr>
<tr>
<td></td>
<td>Check with the system administrator that there is enough bandwidth available. See also the online help.</td>
</tr>
<tr>
<td></td>
<td>Check in the AMC control panel applet (MPEG-4 tab) that video processing is not set to Decode only I frames.</td>
</tr>
<tr>
<td></td>
<td>Lower the image resolution.</td>
</tr>
<tr>
<td>Why don't I get 30 frames per second?</td>
<td>See the section General performance considerations, on page 56.</td>
</tr>
<tr>
<td>Lost or poor images in pre-trigger buffer (MPEG-4 video stream)</td>
<td>Make sure that Cyclic refresh under Setup &gt; Video &amp; Image &gt; Advanced &gt; MPEG-4 is disabled.</td>
</tr>
<tr>
<td>Image degeneration</td>
<td>Decrease the GOV length, see the online help for more information.</td>
</tr>
<tr>
<td>The Power indicator is not constantly lit</td>
<td>Check that you are using an AXIS PS-L power supply.</td>
</tr>
<tr>
<td>The Status and Network indicator LEDs are flashing red rapidly</td>
<td>Contact your Axis dealer.</td>
</tr>
<tr>
<td>The Status indicator LED is flashing red and the camera is inaccessible</td>
<td>See the Emergency Recovery Procedure above.</td>
</tr>
<tr>
<td>No images displayed on web page</td>
<td>To enable the updating of video images in Microsoft Internet Explorer, set your browser to allow ActiveX controls. Also, make sure that AXIS Media Control (AMC) component is installed on your workstation.</td>
</tr>
<tr>
<td>Problems with AMC. (Internet Explorer only)</td>
<td>Configure your camera to use a Java applet for updating the video images under Live View Config &gt; Layout &gt; Default Viewer for Internet Explorer. See the online help for more information.</td>
</tr>
<tr>
<td>Installation of additional ActiveX component restricted or prohibited</td>
<td></td>
</tr>
<tr>
<td>Poor quality snapshot images</td>
<td>In Display Properties, configure your screen to show at least 65000 colors, that is, at least 16-bit. Using only 16 or 256 colors will produce dithering artifacts in the image.</td>
</tr>
<tr>
<td>Browser freezes</td>
<td>Lower the image resolution.</td>
</tr>
<tr>
<td>Problems uploading files</td>
<td>There is only limited space available for the upload of your own files. Try deleting existing files to free up space.</td>
</tr>
<tr>
<td>Motion Detection triggers unexpectedly</td>
<td>Motion detection is based upon changes in luminance in the image. This means that if there are sudden changes in the lighting, motion detection may be triggered mistakenly. Lower the sensitivity setting to avoid problems with luminance.</td>
</tr>
</tbody>
</table>
## Audio

<table>
<thead>
<tr>
<th>Issue</th>
<th>Description and Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>No audio</td>
<td>Check that:</td>
</tr>
<tr>
<td></td>
<td>• PC sound card, speakers and microphone are correctly connected</td>
</tr>
<tr>
<td></td>
<td>• the Mute button is not pressed</td>
</tr>
<tr>
<td></td>
<td>• the volume in and volume out settings are correct</td>
</tr>
<tr>
<td></td>
<td>• all cabling is connected</td>
</tr>
<tr>
<td></td>
<td>• the value of the Post Content Length in your proxy server is 1MB or more. You may need to contact your system administrator to do this.</td>
</tr>
<tr>
<td>No full-duplex function</td>
<td>Incorrect configuration. Check the setting in the camera’s Setup pages.</td>
</tr>
<tr>
<td></td>
<td>Sound card does not support full-duplex. For information on how to check if your sound card supports full-duplex, please visit <a href="http://www.axis.com">www.axis.com</a> and see the support section for Axis camera products.</td>
</tr>
<tr>
<td>Poor performance</td>
<td>Too many users/clients connected. Try limiting the number of clients allowed to connect.</td>
</tr>
<tr>
<td></td>
<td>Low bandwidth. Reduce the Speed setting on the Audio settings page. Setting lower speed will reduce any break-up in the sound, but will also increase the transmission delay. If running in Full-Duplex mode, try switching to Half-Duplex mode.</td>
</tr>
<tr>
<td>Feedback (whining/screeching sound from speakers)</td>
<td>Poor positioning of speakers and/or microphone. Relocate the speakers or microphone so that they do not point towards each other, and/or lower the volume.</td>
</tr>
</tbody>
</table>

For further assistance, please contact your reseller, or check the product’s support pages on the Axis website at http://www.axis.com/techsup.
## Technical Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Models</strong></td>
<td>• AXIS 213 PTZ PTZ 50Hz (PAL)</td>
</tr>
<tr>
<td></td>
<td>• AXIS 213 PTZ PTZ 60Hz (NTSC)</td>
</tr>
<tr>
<td></td>
<td>Supports both desktop and ceiling mounting</td>
</tr>
<tr>
<td><strong>Image sensor</strong></td>
<td>1/4&quot; Interfaced CCD</td>
</tr>
<tr>
<td><strong>Lens</strong></td>
<td>• 3.5-91 mm, F1.6–F4.0</td>
</tr>
<tr>
<td></td>
<td>• Motorized zoom lens</td>
</tr>
<tr>
<td></td>
<td>• Autofocus</td>
</tr>
<tr>
<td></td>
<td>• Manual day/night</td>
</tr>
<tr>
<td><strong>Angle of view</strong></td>
<td>Horizontal: 1.7-42°</td>
</tr>
<tr>
<td><strong>Zoom</strong></td>
<td>• 26x optical</td>
</tr>
<tr>
<td></td>
<td>• 12x digital</td>
</tr>
<tr>
<td><strong>Minimum illumination</strong></td>
<td>• Color mode: 1 lux, F1.6</td>
</tr>
<tr>
<td></td>
<td>• IR mode: 0.1 lux, F1.6, using built-in IR lamp in complete darkness up to 3 m (9.8 ft)</td>
</tr>
<tr>
<td><strong>Pan range</strong></td>
<td>± 170°</td>
</tr>
<tr>
<td><strong>Tilt range</strong></td>
<td>-10° to 90°</td>
</tr>
<tr>
<td><strong>Max speed</strong></td>
<td>• Pan 1–90°/sec</td>
</tr>
<tr>
<td></td>
<td>• Tilt 1–70°/sec</td>
</tr>
<tr>
<td><strong>Video compression</strong></td>
<td>• Motion JPEG</td>
</tr>
<tr>
<td></td>
<td>• MPEG-4 Part 2 (ISO/IEC 14496-2), Profiles: ASP and SP</td>
</tr>
<tr>
<td><strong>Resolutions</strong></td>
<td>• 4CIF, 2CIFExp, 2CIF, CIF, QCIF</td>
</tr>
<tr>
<td></td>
<td>• Max 704x480 (NTSC) 704x576 (PAL)</td>
</tr>
<tr>
<td></td>
<td>• Min 176x120 (NTSC) 176x144 (PAL)</td>
</tr>
<tr>
<td><strong>Frame rate (NTSC/PAL)</strong></td>
<td>• Motion JPEG: Up to 30/25 fps in all resolutions</td>
</tr>
<tr>
<td></td>
<td>• MPEG-4: Up to 21/17 fps at 4CIF/2CIFExp, up to 30/25 fps at 2CIF/CIF/QCIF</td>
</tr>
<tr>
<td><strong>Video streaming</strong></td>
<td>• Simultaneous Motion JPEG and MPEG-4</td>
</tr>
<tr>
<td></td>
<td>• Controllable frame rate and bandwidth</td>
</tr>
<tr>
<td></td>
<td>• Constant and variable bit rate (MPEG-4)</td>
</tr>
<tr>
<td><strong>Image settings</strong></td>
<td>• Compression levels: 11 (Motion JPEG)/23 (MPEG-4)</td>
</tr>
<tr>
<td></td>
<td>• Rotation: 90°, 180°, 270°</td>
</tr>
<tr>
<td></td>
<td>• Backlight compensation</td>
</tr>
<tr>
<td></td>
<td>• Manual IR cut filter Day/Night</td>
</tr>
<tr>
<td></td>
<td>• White balance</td>
</tr>
<tr>
<td></td>
<td>• Color/BW</td>
</tr>
<tr>
<td></td>
<td>• Brightness</td>
</tr>
<tr>
<td></td>
<td>• Noise reduction</td>
</tr>
<tr>
<td></td>
<td>• Exposure control</td>
</tr>
<tr>
<td></td>
<td>• Overlay capabilities: time, date, text, image</td>
</tr>
<tr>
<td></td>
<td>• Aspect ratio correction</td>
</tr>
<tr>
<td></td>
<td>• De-interlace filter(4CIF resolution)</td>
</tr>
<tr>
<td><strong>Pan/Tilt/Zoom</strong></td>
<td>• 20 preset positions</td>
</tr>
<tr>
<td></td>
<td>• Sequence mode</td>
</tr>
<tr>
<td></td>
<td>• Control queue</td>
</tr>
<tr>
<td></td>
<td>• Supports Windows compatible joysticks</td>
</tr>
<tr>
<td></td>
<td>• Designed for operator control*</td>
</tr>
<tr>
<td></td>
<td>*Not for continuous PTZ movements, such as Guard tour</td>
</tr>
<tr>
<td><strong>Audio</strong></td>
<td>• Requires AXIS 213CM Connection Module (optional accessory)</td>
</tr>
<tr>
<td></td>
<td>• Full-duplex, half-duplex or simplex</td>
</tr>
<tr>
<td></td>
<td>• Audio compression: G.711 PCM 64kbit/s, G.726 ADPCM 32 or 24 kbit/s</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>• Multiple user access levels with password protection</td>
</tr>
<tr>
<td></td>
<td>• IP address filtering</td>
</tr>
<tr>
<td><strong>Alarm and event</strong></td>
<td>• Events triggered by built-in motion detection, PTZ preset position, external inputs*, audio detection or according to a schedule</td>
</tr>
<tr>
<td></td>
<td>• Image upload over FTP, email and HTTP</td>
</tr>
<tr>
<td></td>
<td>• Notification over TCP, email, HTTP and external outputs*</td>
</tr>
<tr>
<td></td>
<td>• Pre- and post alarm buffer of 6 MB</td>
</tr>
<tr>
<td></td>
<td>*Requires AXIS 213CM Connection Module (optional accessory)</td>
</tr>
<tr>
<td>Item</td>
<td>Specification</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Connectors</td>
<td>• Ethernet 10BaseT/100BaseTX, RJ-45</td>
</tr>
<tr>
<td></td>
<td>• 26-pin multi-connector (to optional accessory AXIS 213CM Connection Module)</td>
</tr>
<tr>
<td>Casing</td>
<td>Plastic</td>
</tr>
<tr>
<td>Processors, memory, clock</td>
<td>• CPU: ETRAX 100LX 32-bit</td>
</tr>
<tr>
<td></td>
<td>• Video processing and compression: ARTPEC-2</td>
</tr>
<tr>
<td></td>
<td>• RAM: 32 MB</td>
</tr>
<tr>
<td></td>
<td>• Flash memory: 4 MB</td>
</tr>
<tr>
<td></td>
<td>• Real-time clock backed up by battery</td>
</tr>
<tr>
<td>Power</td>
<td>11.5-14V DC, max 13W</td>
</tr>
<tr>
<td>Operating conditions</td>
<td>• Temperature: 5-40°C (41-104°F)</td>
</tr>
<tr>
<td></td>
<td>• Humidity 20-80% RH (non-condensing)</td>
</tr>
<tr>
<td>Installation, management and maintenance</td>
<td>• AXIS Camera Management tool on CD and web-based configuration</td>
</tr>
<tr>
<td></td>
<td>• Configuration of backup and restore</td>
</tr>
<tr>
<td></td>
<td>• Firmware upgrades over HTTP or FTP, firmware available at <a href="http://www.axis.com">www.axis.com</a></td>
</tr>
<tr>
<td>Video access from web browser</td>
<td>• Camera live view</td>
</tr>
<tr>
<td></td>
<td>• Sequence mode for up to 20 PTZ presets or Axis video sources</td>
</tr>
<tr>
<td></td>
<td>• Customizable HTML pages</td>
</tr>
<tr>
<td>Minimum web browsing requirements</td>
<td>• Pentium III CPU 500 MHz or higher, or equivalent AMD</td>
</tr>
<tr>
<td></td>
<td>• 128 MB RAM</td>
</tr>
<tr>
<td></td>
<td>• AGP graphics card with 32 MB RAM</td>
</tr>
<tr>
<td></td>
<td>• Direct Draw</td>
</tr>
<tr>
<td></td>
<td>• Windows XP, 2000</td>
</tr>
<tr>
<td></td>
<td>• DirectX 9.0 or later</td>
</tr>
<tr>
<td></td>
<td>• Internet Explorer 6.x or later</td>
</tr>
<tr>
<td></td>
<td>For other operating systems and browsers see <a href="http://www.axis.com/techsup">www.axis.com/techsup</a></td>
</tr>
<tr>
<td>System integration support</td>
<td>• Open API for application integration including AXIS VAPIX API*, AXIS Media Control SDK*, event trigger data in video stream</td>
</tr>
<tr>
<td></td>
<td>• Embedded Linux operating system</td>
</tr>
<tr>
<td></td>
<td>* Available at <a href="http://www.axis.com">www.axis.com</a></td>
</tr>
<tr>
<td>Supported protocols</td>
<td>IP, HTTP, TCP, ICMP, RTSP, RTP, UDP, IGMP, RTCP, SMTP, FTP, DHCP, UPnP, Bonjour, ARP, DNS, DynDNS, SOCKS, NTP.</td>
</tr>
<tr>
<td></td>
<td>More information on protocol usage available at <a href="http://www.axis.com">www.axis.com</a></td>
</tr>
<tr>
<td>Included accessories</td>
<td>• Installation Guide</td>
</tr>
<tr>
<td></td>
<td>• CD with User’s Manual, demo software, installation and management tools</td>
</tr>
<tr>
<td></td>
<td>• Ceiling and desktop mount kit</td>
</tr>
<tr>
<td></td>
<td>• Power supply 13V DC</td>
</tr>
<tr>
<td></td>
<td>• MPEG-4 licenses (1 encoder, 1 decoder)</td>
</tr>
<tr>
<td></td>
<td>• MPEG-4 decoder (Windows)</td>
</tr>
<tr>
<td>Video management software (not included)</td>
<td>AXIS Camera Station – Surveillance application for viewing, recording and archiving up to 25 cameras</td>
</tr>
<tr>
<td></td>
<td>See <a href="http://www.axis.com/partner/adp_partners.htm">www.axis.com/partner/adp_partners.htm</a> for further software applications via partners</td>
</tr>
<tr>
<td>Accessories (not included)</td>
<td>• AXIS 213CM Connection Module - Provides duplex audio, I/O and analog video output</td>
</tr>
<tr>
<td></td>
<td>• Housings for adverse indoor/outdoor environments</td>
</tr>
<tr>
<td></td>
<td>• AXIS 292 Network Video Decoder</td>
</tr>
<tr>
<td></td>
<td>• AXIS 295 Video Surveillance Joystick</td>
</tr>
<tr>
<td></td>
<td>• IR Illuminators</td>
</tr>
<tr>
<td></td>
<td>• MPEG-4 Decoder multi-user license pack</td>
</tr>
</tbody>
</table>
The AXIS 213 PTZ (PAL) delivers the following file sizes:

<table>
<thead>
<tr>
<th>PAL</th>
<th>PAL aspect ratio corrected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>Min-Max (KB)</td>
</tr>
<tr>
<td>4CIF</td>
<td>704x576</td>
</tr>
<tr>
<td>2CIF expanded</td>
<td>704x576</td>
</tr>
<tr>
<td>2CIF</td>
<td>704x288</td>
</tr>
<tr>
<td>CIF</td>
<td>352x288</td>
</tr>
<tr>
<td>QCIF</td>
<td>176x144</td>
</tr>
</tbody>
</table>

The AXIS 213 PTZ (NTSC) delivers the following file sizes:

<table>
<thead>
<tr>
<th>NTSC</th>
<th>NTSC aspect ratio corrected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolution</td>
<td>Min-Max (KB)</td>
</tr>
<tr>
<td>4CIF</td>
<td>704x480</td>
</tr>
<tr>
<td>2CIF expanded</td>
<td>704x480</td>
</tr>
<tr>
<td>2CIF</td>
<td>704x240</td>
</tr>
<tr>
<td>CIF</td>
<td>352x240</td>
</tr>
<tr>
<td>QCIF</td>
<td>176x120</td>
</tr>
</tbody>
</table>

General performance considerations

When setting up the camera, it is important to consider how various settings and situations affect performance. Some factors affect the amount of bandwidth (the bit rate) required, others can affect the frame rate, and some affect both. If the load on the CPU reaches its maximum, this also affects the frame rate.

The following factors are among the most important to consider:

- High image resolutions and/or lower compression levels result in larger images. Bandwidth affected.
- Access by large numbers of Motion JPEG and/or unicast MPEG-4 clients. Bandwidth affected.
- Simultaneous viewing of different streams (resolution, compression, etc.) by many clients. Frame rate and bandwidth affected.
- Accessing both Motion JPEG and MPEG-4 video streams simultaneously. Frame rate and bandwidth affected.
- Heavy usage of event settings affects the CPU load. Frame rate affected.
- Enabled motion detection. Frame rate and bandwidth affected.
- Heavy network utilization due to poor infrastructure. Bandwidth affected.
- Viewing on poorly performing client PC lowers perceived performance. Frame rate affected.
- Access by large number of audio clients using full-duplex mode. Bandwidth affected.
Optimizing your system

To see the bandwidth and frame rate currently required by the video stream, the AXIS 213 PTZ provides a tool that can be used to display these values directly in the video image.

To do this, special format strings are added as part of a text overlay. Simply add \#r (average frame rate in fps) and/or \#b (average bandwidth in Kbps) to the overlay.

For detailed instructions, please see the online help for Video & Image > Overlay Settings, and the help for File Naming & Date/Time Formats.

Important!

The figures displayed here are the values as delivered by the camera. If other restrictions are currently in force, (bandwidth limitation, for example) these values might not correspond to those actually received by the client.

For Motion JPEG, these values will only be accurate as long as no frame rate limit has been specified.

Frame rates - Motion JPEG

The following test results show the frame rates in frames/second (fps) for Motion JPEG streams from the AXIS 213 PTZ, using a compression level of 50%. Note that these values are guidelines only - actual values may vary.

<table>
<thead>
<tr>
<th></th>
<th>fps</th>
</tr>
</thead>
<tbody>
<tr>
<td>4CIF</td>
<td>25/30</td>
</tr>
<tr>
<td>2CIF</td>
<td>25/30</td>
</tr>
<tr>
<td>CIF</td>
<td>25/30</td>
</tr>
<tr>
<td>QCIF</td>
<td>25/30</td>
</tr>
</tbody>
</table>

Frame rates - MPEG-4

The following test results show the frame rates in frames/second (fps) for MPEG-4 streams from the AXIS 213 PTZ. Note that these values are guidelines only - actual values may vary.

The MPEG-4 test conditions:

- Compression level = 50%
- Video Object Type = Advanced Simple
- GOV structure = IP*

<table>
<thead>
<tr>
<th></th>
<th>fps</th>
</tr>
</thead>
<tbody>
<tr>
<td>4CIF</td>
<td>17/21</td>
</tr>
<tr>
<td>2CIF</td>
<td>17/21</td>
</tr>
<tr>
<td>CIF</td>
<td>25/30</td>
</tr>
<tr>
<td>QCIF</td>
<td>25/30</td>
</tr>
</tbody>
</table>

*Note that setting the GOV structure to use “I-frames only” will increase the frame rate.
**Bandwidth**

As there are many factors affecting bandwidth. They are:

- the image resolution
- the image compression
- the frame rate
- the MPEG-4 object type
- the MPEG-4 GOV structure
- the audio settings

There are also factors in the monitored scene that affect the bandwidth. These are:

- the amount of motion
- the image's complexity
- the lighting conditions.

For MPEG-4, if there is only limited bandwidth available, and if this is more important than the image quality, using a constant bit rate (CBR) is recommended. Use a variable bit rate (VBR) if the image quality needs to be maintained at a higher level. If supported on the network, consider also using MPEG-4 multicasting, as the bandwidth consumption will be lower.
Glossary of Terms

ActiveX – A standard that enables software components to interact with one another in a networked environment, regardless of the language(s) used to create them. Web browsers may come into contact with ActiveX controls, ActiveX documents, and ActiveX scripts. ActiveX controls are often downloaded and installed automatically as required.

AF (Autofocus) – A system by which the camera lens automatically focuses on a selected part of the subject.

Angle – The field of view, relative to a standard lens in a 35mm still camera, expressed in degrees, such as 30°. For practical purposes, this is the area that a lens can cover, where the angle of view is determined by the focal length of the lens. A wide-angle lens has a short focal length and covers a wider angle of view than standard or telephoto lenses, which have longer focal lengths.

ASIC (Application Specific Integrated Circuit) – A circuit designed for a specific application, as opposed to a general purpose circuit, such as a microprocessor.

Aspect ratio – A ratio of width to height in images. A common aspect ratio used for television screens and computer monitors is 4:3. High-definition television (HDTV) uses an aspect ratio of 9:16.

Autoiris (or DC-Iris) – This special type of iris is electrically controlled by the camera, to automatically regulate the amount of light allowed to enter.

ARP (Address Resolution Protocol) – This protocol is used to associate an IP address to a hardware MAC address. A request is broadcast on the local network to discover the MAC address for an IP address.

ARTPEC (Axis Real Time Picture Encoder) – This chip is used for image compression.

ASIC (Application Specific Integrated Circuit) – A circuit designed for a specific application, as opposed to a general purpose circuit, such as a microprocessor.

Autoiris (or DC-Iris) – This special type of iris is electrically controlled by the camera, to automatically regulate the amount of light allowed to enter.

AVI (Audio Video Interleave) – A video format that supports simultaneous playback of audio and video.

Bitmap – A bitmap is a data file representing a rectangular grid of pixels. It defines a display space and color for each pixel (or “bit”) in the display space. This type of image is known as a “raster graphic.” GIFs and JPEGs are examples of image file types that contain bitmaps.

Because a bitmap uses this fixed raster method, it cannot easily be rescaled without losing definition. Conversely, a vector graphic image uses geometrical shapes to represent the image, and can thus be quickly rescaled.

Bit rate – The bit rate (in kbit/s or Mbit/s) is often referred to as speed, but actually defines the number of bits/time unit and not distance/time unit.

Bluetooth – Bluetooth is an open standard for wireless transmission of voice and data between mobile devices (PCs, handheld computers, telephones and printers).

Bonjour – Also known as zero-configuration networking, Bonjour enables devices to automatically discover each other on a network, without having to enter IP addresses or configure DNS servers. Bonjour is a trademark of Apple Computer, Inc.

Broadband – In network engineering terms, this describes transmission methods where two or more signals share the same carrier. In more popular terminology, broadband is taken to mean high-speed data transmission.

CCD (Charged Coupled Device) – This light-sensitive image device used in many digital cameras is a large integrated circuit that contains hundreds of thousands of photo-sites (pixels) that convert light energy into electronic signals. Its size is measured diagonally and can be 1/4", 1/3", 1/2" or 2/3".

CGI (Common Gateway Interface) – A specification for communication between a web server and other (CGI) programs. For example, a HTML page that contains a form might use a CGI program to process the form data once it is submitted.

CIF (Common Intermediate Format) – CIF refers to the analog video resolutions 352x288 pixels (PAL) and 352x240 pixels (NTSC). See also Resolution.

Client/Server – Client/server describes the relationship between two computer programs in which one program, the client, makes a service request from another program, the server, which fulfills the request. Typically, multiple client programs share the services of a common server program. A web browser is a client program that requests services (the sending of web pages or files) from a web server.

CMOS (Complementary Metal Oxide Semiconductor) – A CMOS is a widely used type of semiconductor that uses both negative and positive circuits. Since only one of the circuit types is on at any given time, CMOS chips require less power than chips using just one type of transistor. CMOS image sensors also allow processing circuits to be included on the same chip, an advantage not possible with CCD sensors, which are also much more expensive to produce.

Codec – In communications engineering, a codec is usually a coder/decoder. Codecs are used in integrated circuits or chips that convert analog video and audio signals into a digital format for transmission. The codec also converts received digital signals back into analog format. A codec uses analog-to-digital conversion and digital-to-analog conversion in the same chip.

Codec can also mean compression/decompression, in which case it is generally taken to mean an algorithm or computer program for reducing the size of large files and programs.

Compression – See Image Compression.

Contrast – Defines the degree of difference between the lightest and darkest parts of an image or video stream.

DC-Iris – This special type of iris is electrically controlled by the camera, to automatically regulate the amount of light allowed to enter.

DHCP (Dynamic Host Configuration Protocol) – DHCP is a protocol that lets network administrators automate and centrally manage the assignment of Internet Protocol (IP) addresses to network devices in a network.

DHCP uses the concept of a "lease" or amount of time that a given IP address will be valid for a computer. The lease time can vary, depending on how long a user is likely to require the network connection at a particular location.

DHCP also supports static addresses for computers running web servers, which need a permanent IP address.

DNS (Domain Name System) – DNS is used to locate and translate Internet domain names into IP (Internet Protocol) addresses. A domain name is a meaningful and easy-to-remember name for an Internet address. For example the domain name www.example.com is much easier to remember than 192.0.34.166. The translation tables for domain names are contained in Domain name servers.

Domain Server – Domains can also be used by organizations who wish to centralize the management of their (Windows) computers. Each user within a domain has an account that usually allows them to log in to and use any computer in the domain, although restrictions may also apply. The domain server is the server that authenticates the users on the network.

Duplex – See Full-duplex.

Ethernet – Ethernet is the most widely installed local area network technology. An Ethernet LAN typically uses special grades of twisted pair wires. The most commonly installed Ethernet systems are 10BASE-T and 100BASE-T10, which provide transmission speeds up to 10 Mbps and 100 Mbps respectively.

ETRAX (Ethernet Token Ring AXIS) – Axis’ own microprocessor.

Factory default settings – These are the settings that originally applied for a device when it was first delivered from the factory. If it should become necessary to reset a device to its factory default settings, this will, for many devices, completely reset any settings that were changed by the user.
Firewall – A firewall works as a barrier between networks, between a Local Area Network and the Internet. The firewall ensures that only authorized users are allowed to access the one network from the other. A firewall can be software running on a computer, or it can be a standalone hardware device.

Focal length – Measured in millimeters, the focal length of a camera lens determines the width of the horizontal field of view, which in turn is measured in degrees.

FTP (File Transfer Protocol) – An application protocol that uses the TCP/IP protocols. It is used to exchange files between computers/devices on networks.

Frame – A frame is a complete video image. In the 2:1 interlaced scanning format of the RS-170 and CCIR formats, a frame is made up of two separate fields of 262.5 or 312.5 lines interlaced at 60 or 50 Hz to form a complete frame, which appears at 30 or 25 Hz. In video cameras with a progressive scan, each frame is scanned line-by-line and not interlaced; most are also displayed at 30 and 25 Hz.

Frame rate - The frame rate used to describe the frequency at which a video stream is updated is measured in frames per second (fps). A higher frame rate is advantageous when there is movement in the video stream, as it maintains image quality throughout.

Full-duplex – Transmission of data in two directions simultaneously. In an audio system this would describe a telephone systems. Half-duplex also provides bi-directional communication, but only in one direction at a time, as in a walkie-talkie system. See also Simplex.

Gain – Gain is the amplification factor and the extent to which an analog amplifier boosts the strength of a signal. Amplification factors are usually expressed in terms of power. The decibel (dB) is the most common way of quantifying the gain of an amplifier.

Gateway - A gateway is a point in a network that acts as an entry point to another network. In a corporate network for example, a computer server acting as a gateway often also acts as a proxy server and a firewall server. A gateway is often associated with both a router, which knows where to direct a given packet of data that arrives at the gateway, and a switch, which furnishes the actual path in and out of the gateway for a given packet.

GIF (Graphics Interchange Format) – GIF is one of the most common file formats used for images in web pages. There are two versions of the format, 87a and 89a. Version 89a supports animations, that is, a short sequence of images within a single GIF file. A GIF89a can also be specified for interlaced presentation.

GOV (Group Of VOPs) – A group of VOPs is the basic unit of an MPEG-4 video stream. The GOV contains different types and numbers of VOPs (I-VOPs, P-VOPs, etc) as determined by the GOV length and GOV structure. See also VOP.

GOV length - The GOV length determines the number of images (VOPs) in the GOV structure. See also GOV and VOP.

GOV structure - The GOV structure describes the composition of an MPEG-4 video stream, as regards the type of images (I-VOPs or P-VOPs) included in the stream, and their internal order. See also GOV and VOP.

Half-duplex – See Full-duplex.

HTML (Hypertext Markup Language) – HTML is the set of "markup" symbols or codes inserted in a file intended for display in web browser. The markup tells the browser how to display the page’s words and images for the user.

HTTP (Hypertext Transfer Protocol) - HTTP is the set of rules for exchanging files (text, graphic images, sound, video, and other multimedia files) on the web. The HTTP protocol runs on top of the TCP/IP suite of protocols.

Hub - A (network) hub is used to connect multiple devices to the network. The hub transmits all data to all devices connected to it, whereas a switch will only transmit the data to the device it is specifically intended for.

IEEE 802.11 – A family of standards for wireless LANs. The 802.11 standard supports 1 or 2 Mbit/s transmission on the 2.4 GHz band. IEEE 802.11b specifies an 11 Mbit/s data rate on the 2.4 GHz band, while 802.11a allows up to 54 Mbit/s on the 5 GHz band.

Image compression – Image compression minimizes the file size (in bytes) of an image. Two of the most common compressed image formats are JPEG and GIF.

Interlacing – Interlaced video is video captured at 50 pictures (known as fields) per second, of which every 2 consecutive fields (at half height) are then combined into 1 frame. Interlacing was developed many years ago for the analog TV world and is still used widely today. It provides good results when viewing motion in standard TV pictures, although there is always some degree of distortion in the image.

To view interlaced video on a computer monitor, the video must first be de-interlaced, to produce progressive video, which consists of complete images, one after the other, at 25 frames per second. See also Progressive scan.

IP (Internet Protocol) - The Internet Protocol is a method transmitting data over a network. Data to be sent is divided into individual and completely independent "packets." Each computer (or host) on the Internet has at least one address that uniquely identifies it from all others, and each data packet contains both the sender’s address and the receiver's address.

The Internet Protocol ensures that the data packets all arrive at the intended address. As IP is a connectionless protocol, which means that there is no established connection between the communication end-points, packets can be sent via different routes and do not need to arrive at the destination in the correct order.

Once the data packets have arrived at the correct destination, another protocol - Transmission Control Protocol (TCP) - puts them in the right order. See also TCP.

IP Address – An IP address is simply an address on an IP network used by a computer/device connected to that network. IP addresses allow all the connected computers/devices to find each other and to pass data back and forth.

To avoid conflicts, each IP address on any given network must be unique. An IP address can be assigned as fixed, so that it does not change, or it can be assigned dynamically (and automatically) by DHCP.

An IP address consists of four groups (or quads) of decimal digits separated by periods, such as 130.5.5.25. Different parts of the address represent different things. Some part will represent the network number or address, and some other part will represent the local machine address.

See also IP (Internet Protocol).

I-VOP – See VOP.

JPEG (Joint Photographic Experts Group) – Together with the GIF file format, JPEG is an image file type commonly used on the web. A JPEG image is a bitmap, and usually has the file suffix ‘.jpg’ or ‘.jpeg.’ When creating a JPEG image, it is possible to configure the level of compression to use. As the lowest compression (the highest quality) results in the largest file, there is a trade-off between image quality and file size.

kbit/s (kilobits per second) - A measure of the bit rate, that is, the rate at which bits are passing a given point. See also Bit rate.

LAN (Local Area Network) – A LAN is a group of computers and associated devices that typically share common resources within a limited geographical area.

Linux – Linux is an open source operating system within the Unix family. Because of its robustness and availability, Linux has won popularity in the open source community and among commercial application developers.

MAC address (Media Access Control address) – A MAC address is a unique identifier associated with a piece of networking equipment, or more specifically, its interface with the network. For example, the network card in a computer has its own MAC address.

Manual iris - This is the opposite to an autoiris, where the camera iris must be adjusted manually to regulate the amount of light allowed to reach the image sensor.
Mbit/s (Megabits per second) – A measure of the bit rate, that is, the rate at which bits are passing a given point. Commonly used to give the "speed" of a network. A LAN might run at 10 or 100 Mbit/s. See also Bit rate.

Monitor – A monitor is very similar to a standard television set, but lacks the electronics to pick up regular television signals.

Motion JPEG – Motion JPEG is a simple compression/decompression technique for networked video. Latency is low and image quality is guaranteed, regardless of movement or complexity of the images. Image quality is controlled by adjusting the compression level, which in turn provides control over the file size, and thereby the bit rate.

High-quality individual images from the Motion JPEG stream are easily extracted. See also JPEG.

Megapixel – See Pixel.

MPEG (Moving Picture Experts Group) – The Moving Picture Experts Group develops standards for digital video and audio compression. It operates under the auspices of the International Organization for Standardization (ISO). The MPEG standards are an evolving series, each designed for a different purpose.

MPEG-2 – MPEG-2 is the designation for a group of audio and video coding standards, and is typically used to encode audio and video for broadcast signals, including digital satellite and Cable TV. MPEG-2, with some modifications, is also the coding format used by standard commercial DVD movies.

MPEG-4 – MPEG-4 is a group of audio and video coding standards and related technology. The primary uses for the MPEG-4 standard are web (streaming media) and CD distribution, conversational (videophone), and broadcast television.

Most of the features included in MPEG-4 are left to individual developers to decide whether to implement them or not. This means that there are probably no complete implementations of the entire MPEG-4 set of standards. To deal with this, the standard includes the concept of "profiles" and "levels", allowing a specific set of capabilities to be defined in a manner appropriate for a subset of applications.

Multicast – Bandwidth-conserving technology that reduces bandwidth usage by simultaneously delivering a single stream of information to multiple network recipients.

Multiplexer – A multiplexer is a high-speed switch that provides full-screen images from up to 16 analog cameras. Multiplexers can playback everything that happened on any one camera with no interference from the other cameras on the system.

Network connectivity – The physical (wired or wireless) and logical (protocol) connection of a computer network or an individual device to a network, such as the Internet or a LAN.

NTSC (National Television System Committee) – NTSC is the television and video standard in the United States. NTSC delivers 525 lines at 60 half-frames/second.

OEM (Original Equipment Manufacturers) – This is a designation for companies that manufacture equipment which is then marketed and sold to other companies under their own names.

PAL (Phase Alternating Line) – PAL is the dominant television standard in Europe. PAL delivers 625 lines at 50 half-frames/second.

P-VOP – P-VOP is a special set of rules governing how two entities will communicate. Protocols are found at many levels of communication, and there are hardware protocols and software protocols.

Proxy server – In an organization that uses the Internet, a proxy server acts as an intermediary between a workstation user and the Internet. This provides security, administrative control, and a caching service. Any proxy server associated with a gateway server, or part of a gateway server, effectively separates the organization's network from the outside network and the local firewall. It is the firewall server that protects the network against outside intrusion.

A proxy server receives requests for Internet services (such as web page requests) from many users. If the proxy server is also a cache server, it looks in its local cache of previously downloaded web pages. If it finds the page, it is returned to the user without forwarding the request to the Internet. If the page is not in the cache, the proxy server, acting as a client on behalf of the user, uses one of its own IP addresses to request the page from another server over the Internet. When the requested page is returned, the proxy server forwards it to the user that originally requested it.

P-VOP – See VOP.

Resolution – Image resolution is a measure of how much detail a digital image can hold; the greater the resolution, the greater the level of detail. Resolution can be specified as the number of pixel-columns (width) by the number of pixel-rows (height), such as 320x240. Alternatively, the total number of pixels (usually in megapixels) in the image can be used. In analog systems it is also common to use other format designations, such as CIF, QCIF, 4CIF, etc.

RTCP (Real-Time Control Protocol) – RTCP provides support for real-time conferencing of groups of any size within an intranet. This support includes source identification and support for gateways like audio and video bridges as well as multicast-to-unicast translators. RTCP offers quality-of-service feedback from receivers to the multicast group as well as support for the synchronization of different media streams.

RTP (Real-Time Transport Protocol) – RTP is an Internet protocol for the transport of real-time data, such as audio and video. It can be used for media-on-demand as well as interactive services such as Internet telephony.
RTSP (Real Time Streaming Protocol) - RTSP is a control protocol, and a starting point for negotiating transports such as RTP, multicast and Unicast, and for negotiating codecs.

RTSP can be considered a "remote control" for controlling the media stream delivered by a media server. RTSP servers typically use RTP as the protocol for the actual transport of audio/video data.

Router - A device that determines the next network point to which a packet should be forwarded on its way to its final destination. A router creates and/or maintains a special routing table that stores information on how best to reach certain destinations. A router is sometimes included as part of a switch. See also switch.

Server - In general, a server is a computer program that provides services to other computer programs in the same or other computers. A computer running a server program is also frequently referred to as a server. In practice, the server may contain any number of server and client programs. A web server is the computer program that supplies the requested HTML pages or files to the client (browser).

SMTP (Simple Mail Transfer Protocol) - SMTP is used for sending and receiving e-mail. However, as it is "simple," it is limited in its ability to queue messages at the receiving end, and is usually used with one of two other protocols, POP3 or IMAP. These other protocols allow the user to save messages in a server mailbox and download them periodically from the server.

SMTP authentication is an extension of SMTP, whereby the client is required to log into the mail server before or during the sending of email. It can be used to allow legitimate users to send email while denying the service to unauthorized users, such as spammers.

SNMP (Simple Network Management Protocol) - SNMP forms part of the Internet Protocol suite, as defined by the Internet Engineering Task Force. The protocol can support monitoring of network-attached devices for any conditions that warrant administrative attention.

Sockets - Sockets are a method for communication between a client program and a server program over a network. A socket is defined as "the endpoint in a connection." Sockets are created and used with a set of programming requests or "function calls" sometimes called the sockets application programming interface (API).

SSL/TSL (Secure Socket Layer/Transport Layer Security) - These two protocols (SSL is succeeded by TSL) are cryptographic protocols that provide secure communication on a network. SSL is commonly used over HTTP to form HTTPS, as used e.g. on the Internet for electronic financial transactions. SSL uses public key certificates to verify the identity of the server.

Subnet/subnet mask - A subnet is an identifiable separate part of an organization's network. Typically, a subnet may represent all the machines at one geographic location, in one building, or on the same local area network (LAN). Having an organization's network divided into subnets allows it to be connected to the Internet with a single shared network address.

TCP (Transmission Control Protocol) - TCP is used along with the Internet Protocol (IP) to transmit data as packets between computers over the network. While IP takes care of the actual packet delivery, TCP keeps track of the individual packets that the communication (e.g. requested a web page file) is divided into, and, when all packets have arrived at their destination, it reassembles them to re-form the complete file.

TCP is a connection-oriented protocol, which means that a connection is established between the two end-points and is maintained until the data has been successfully exchanged between the communicating applications.

Telnet - Telnet is a simple method with which to access another network device, e.g. a computer. The HTTP protocol and the FTP protocols allow you to request specific files from remote computers, but do not allow you logon as a user of that computer. With Telnet, you log on as a regular user with whatever privileges you may have been granted for specific applications and data residing on that computer.

Unicast - Communication between a single sender and a single receiver over a network. A new connection is established for each new user.

URL (Uniform Resource Locator) - An "address" on the network.

WAN (Wide-Area-Network) - A VOP is an image frame in an MPEG-4 video stream. There are several types of VOP:
- An I-VOP is complete image frame.
- A P-VOP codes the differences between images, as long as it is more efficient to do so. Otherwise it codes the whole image, which may also be a completely new image.

UDP (User Datagram Protocol) - UDP is a communications protocol that offers limited service for exchanging data in a network that uses the Internet Protocol (IP). UDP is an alternative to the Transmission Control Protocol (TCP). The advantage of UDP is that it is not required to deliver all data and may drop network packets when there is e.g. network congestion. This is suitable for live video, as there is no point in re-transmitting old information that will not be displayed anyway.

Telnet is a simple method with which to access another network device, e.g. a computer. The HTTP protocol and the FTP protocols allow you to request specific files from remote computers, but do not allow you logon as a user of that computer. With Telnet, you log on as a regular user with whatever privileges you may have been granted for specific applications and data residing on that computer.

Telnet - Telnet is a simple method with which to access another network device, e.g. a computer. The HTTP protocol and the FTP protocols allow you to request specific files from remote computers, but do not allow you logon as a user of that computer. With Telnet, you log on as a regular user with whatever privileges you may have been granted for specific applications and data residing on that computer.

Varifocal lens - A varifocal lens provides a wide range of focal lengths, as opposed to a lens with a fixed focal length, which only provides one.

VPN (Virtual Private Network) - This creates a secure "tunnel" between the points within the VPN. Only devices with the correct "key" will be able to work within the VPN. The VPN network can be within a company LAN (Local Area Network), but different sites can also be connected over the Internet in a secure way. One common use for VPN is for connecting a remote computer to the corporate network, via e.g. a direct phone line or via the Internet.

VOP (Video Object Plane) - A VOP is an image frame in an MPEG-4 video stream. There are several types of VOP:
- An I-VOP is complete image frame.
- A P-VOP codes the differences between images, as long as it is more efficient to do so. Otherwise it codes the whole image, which may also be a completely new image.

VOP (Video Object Plane) - A VOP is an image frame in an MPEG-4 video stream. There are several types of VOP:
- An I-VOP is complete image frame.
- A P-VOP codes the differences between images, as long as it is more efficient to do so. Otherwise it codes the whole image, which may also be a completely new image.

WAN (Wide-Area-Network) - Similar to a LAN, but on a larger geographical scale.

W-LAN (Wireless LAN) - A wireless LAN is a wireless local area network that uses radio waves as its carrier: where the network connections for end-users are wireless. The main network structure usually uses cables.

Web server - A Web server is a program, which allows Web browsers to retrieve files from computers connected to the Internet. The Web server listens for requests from Web browsers and upon receiving a request for a file sends it back to the browser.

The primary function of a Web server is to serve pages to other remote computers; consequently, it needs to be installed on a computer that is permanently connected to the Internet. It also controls access to the server whilst monitoring and logging server access statistics.

WEP (Wireless Equivalent Privacy) - A wireless security protocol, specified in the IEEE 802.11 standard, which is designed to provide a wireless local area network (WLAN) with a level of security and privacy comparable to that usually expected of a wired LAN. Security
is at two different levels; 40-bit and 128-bit encryption. The higher the bit number, the more secure the encryption.

**WINS (Windows Internet Naming Service)** – Part of the Microsoft Windows NT Server, WINS manages the association of workstation names and locations with IP addresses, without the user or administrator having to be involved in each configuration change.

**WPA-PSK (Wi-Fi Protected Access - Pre-Shared Key)** – This wireless encryption method uses a pre-shared key (PSK) for key management. Keys can usually be entered as manual hex values, as hexadecimal characters, or as a Passphrase. WPA-PSK provides a greater degree of security than WEP.
Zoom lens - A zoom lens can be moved (zoomed) to enlarge the view of an object to show more detail.
# Index

<table>
<thead>
<tr>
<th>A</th>
<th>Accessing the video stream 13</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Action 25</td>
</tr>
<tr>
<td></td>
<td>Action Buttons 22</td>
</tr>
<tr>
<td></td>
<td>Active/Inactive 22</td>
</tr>
<tr>
<td></td>
<td>Administrators 14</td>
</tr>
<tr>
<td></td>
<td>Advanced Simple profile 11</td>
</tr>
<tr>
<td></td>
<td>Alarm 25, 27</td>
</tr>
<tr>
<td></td>
<td>AMC 9, 12</td>
</tr>
<tr>
<td></td>
<td>Audio 19</td>
</tr>
<tr>
<td></td>
<td>Audio input 20</td>
</tr>
<tr>
<td></td>
<td>Audio mode 19</td>
</tr>
<tr>
<td></td>
<td>Audio output 20</td>
</tr>
<tr>
<td></td>
<td>AXIS Media Control 19</td>
</tr>
<tr>
<td>B</td>
<td>Backup 33</td>
</tr>
<tr>
<td></td>
<td>Bandwidth 11, 46</td>
</tr>
<tr>
<td></td>
<td>Bit rate 11</td>
</tr>
<tr>
<td></td>
<td>Buffer Size 26</td>
</tr>
<tr>
<td></td>
<td>Buffers 26</td>
</tr>
<tr>
<td>C</td>
<td>CGI links 22</td>
</tr>
<tr>
<td></td>
<td>Connection Module 6, 35</td>
</tr>
<tr>
<td></td>
<td>Constant bit rate 11</td>
</tr>
<tr>
<td></td>
<td>Control Panel 9</td>
</tr>
<tr>
<td>D</td>
<td>Date &amp; Time 29</td>
</tr>
<tr>
<td></td>
<td>Default 33</td>
</tr>
<tr>
<td></td>
<td>Default Video Format 22</td>
</tr>
<tr>
<td></td>
<td>Default Viewer 23</td>
</tr>
<tr>
<td></td>
<td>DNS Configuration 30</td>
</tr>
<tr>
<td></td>
<td>DNS Server 30</td>
</tr>
<tr>
<td></td>
<td>Domain Name 30</td>
</tr>
<tr>
<td>E</td>
<td>Event 25</td>
</tr>
<tr>
<td></td>
<td>Event Servers 25</td>
</tr>
<tr>
<td></td>
<td>Event Types 26</td>
</tr>
<tr>
<td>F</td>
<td>Factory Default 34</td>
</tr>
<tr>
<td></td>
<td>File Sizes (NTSC) 44</td>
</tr>
<tr>
<td></td>
<td>File Sizes (PAL) 44</td>
</tr>
<tr>
<td></td>
<td>Frame Rate 15</td>
</tr>
<tr>
<td></td>
<td>Frame rates 45</td>
</tr>
<tr>
<td></td>
<td>FTP Server 25</td>
</tr>
<tr>
<td></td>
<td>Full duplex 19</td>
</tr>
<tr>
<td>H</td>
<td>Half duplex 19</td>
</tr>
</tbody>
</table>

| I | Include windows 27            |
|   | IP Address Filtering 29       |
|   | IR Light 5                    |
|   | IR light 9                    |
| L | LED Settings 33               |
|   | Live View 14                  |
|   | Live View Config 21           |
|   | Logs & Reports 33             |
| M | Motion Detection 27           |
|   | Motion JPEG 11                |
|   | MPEG-4 5, 11, 17, 32          |
|   | MPEG-4 protocols 12           |
|   | Multicasting 12               |
| N | NAT Traversal 31              |
|   | Network 30                    |
|   | Network Connector 5           |
|   | Network Indicator 5           |
|   | New Server Time 29            |
|   | NTP Configuration 31          |
|   | NTP Server 30                 |
| O | Other MPEG-4 clients 13       |
|   | Output Buttons 22             |
|   | Overlay Image 16              |
|   | Overlay Settings 15           |
|   | Own Home Page 21              |
|   | Own web files 21              |
| P | Pan/Tilt/Zoom Control Queue 10|
|   | Password 7                    |
|   | Pinout 32                     |
|   | Port Status 28                |
|   | Ports & Devices 32            |
|   | Post-trigger Buffer 26        |
|   | Power Connector 5             |
|   | Pre-trigger Buffer 26         |
|   | PTZ Commands 22               |
|   | Pulse 8, 22                   |
|   | Push to talk 19               |
Q
QuickTime 23

R
Referrals 29
Reset Button 5, 34
Restart 33
Restore 33
RTP 12
RTP (multicast) 32
RTSP 12

S
Scheduled Event 25, 27
Security 29
Security/Users 29
Sequence Mode 8
Serial Number 5
Services 30
Setup 14
Shortcuts 9
Simple profile 11
SMTP 32
Snapshot 8
SNMP 32
SOCKS 32
Streaming MPEG-4 12
Support 33
System Options 29
System Overview 33

T
TCP Server 25
Time Mode 30
Triggered Event 25, 26
Troubleshooting 37

U
UDP 12
Unicasting 12
Upgrade Server 33
UPnP 32
User Defined Links 22
User List 29

V
Variable bit rate 11
Viewer settings 23